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Copyright and Trademark Notice 
Thecus and other names of Thecus products are registered trademarks of Thecus 
Technology Corp. Microsoft, Windows, and the Windows logo are registered 
trademarks of Microsoft Corporation. Apple, iTunes and Apple OS X are registered 
trademarks of Apple Computers, Inc. All other trademarks and brand names are 
the property of their respective owners. Specifications are subject to change 
without notice. 
 
Copyright © 2008 Thecus Technology Corporation. All rights reserved. 
 

About This Manual 
All information in this manual has been carefully verified to ensure its correctness. 
In case of an error, please provide us with your feedback.  Thecus Technology 
Corporation reserves the right to modify the contents of this manual without 
notice. 
 
Product name: Thecus M3800 
Manual Version: 1.1 
Release Date: October 2008 
 

Limited Warranty 
Thecus Technology Corporation guarantees all components of Thecus M3800 are 
thoroughly tested before they leave the factory and should function normally 
under general usage.  In case of any system malfunctions, Thecus Technology 
Corporation and its local representatives and dealers are responsible for repair 
without cost to the customer if the product fails within the warranty period and 
under normal usage. Thecus Technology Corporation is not responsible for any 
damage or loss of data deemed to be caused by its products. It is highly 
recommended that users conduct necessary back-up practices. 
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Safety Warnings 
 
For your safety, please read and follow the following safety warnings: 
 

 Read this manual thoroughly before attempting to set up your M3800. 
 

 Your M3800 is a complicated electronic device. DO NOT attempt to repair 
it under any circumstances. In the case of malfunction, turn off the power 
immediately and have it repaired at a qualified service center. Contact 
your vendor for details. 

 
 DO NOT allow anything to rest on the power cord and DO NOT place the 
power cord in an area where it can be stepped on. Carefully place 
connecting cables to avoid stepping or tripping on them. 

 
 Your M3800 can operate normally under temperatures between 5°C and 
40°C, with relative humidity of 0% – 80%. Using the M3800 under 
extreme environmental conditions could damage the unit. 

 
 Ensure that the M3800 is provided with the correct supply voltage (AC 
100V ~ 240V, 50/60 Hz, 3A). Plugging the M3800 to an incorrect power 
source could damage the unit. 

 
 Do NOT expose the M3800 to dampness, dust, or corrosive liquids. 

 
 Do NOT place the M3800 on any uneven surfaces. 

 
 DO NOT place the M3800 in direct sunlight or expose it to other heat 
sources. 

 
 DO NOT use chemicals or aerosols to clean the M3800. Unplug the power 
cord and all connected cables before cleaning.  

 
 DO NOT place any objects on the M3800 or obstruct its ventilation slots to 
avoid overheating the unit. 

 
 Keep packaging out of the reach of children. 

 
 If disposing of the device, please follow your local regulations for the safe 
disposal of electronic products to protect the environment. 
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Chapter 1: Introduction 

Overview 
Thank you for choosing the Thecus M3800 IP Storage Appliance. The Thecus 
M3800 is an easy-to-use storage server that allows a dedicated approach to 
storing and distributing data on a network. Data reliability is ensured with RAID 
features that provide data security and recovery—over 3 Terabytes of storage is 
available. Gigabit Ethernet ports enhance network efficiency, allowing the M3800 
to take over file management functions, increase application and data sharing 
and provide faster data response. The M3800 lets you hot swap working hard 
drives, securing the continuity of data in the event of hardware failure. The 
M3800 allows data consolidation and sharing between Windows (SMB/CIFS), 
UNIX/Linux, and Apple OS X environments. The M3800’s user-friendly GUI 
supports multiple languages. 

Product Highlights 

File Server 
First and foremost, the M3800 allows you to store and share files over an IP 
network. With a Network Attached Storage (NAS) device, you can centralize your 
files and share them easily over your network. With the easy-to-use web-based 
interface, users on your network can access these files in a snap. 
 
To learn about the Web User Interface, go to Chapter 6: Using the M3800 > 
Web User Interface. 

FTP Server 
With the built-in FTP Server, friends, clients, and customers can upload and 
download files to your M3800 over the Internet with their favorite FTP programs. 
You can create user accounts so that only authorized users have access.  
 
To set up the FTP Server, refer to Chapter 5: Additional Feature Setup > FTP 
Server. 

Backup Server 
Don’t leave precious data to chance. With advanced backup capabilities, you can 
easily upload mission critical files to the M3800, and even automate your backup 
tasks for true peace-of-mind. 
 
To find out how to backup your files with the M3800, refer to Chapter 6: Using 
the M3800 > File Backup. 

Media Server 
Mediabolic’s Embedded Media Server resides on the M3800 and aggregates 
personal media so that it was can be accessed by a variety of players, such as 
network TVs, IP set-top boxes, and digital media adapters. This software is DLNA 
Certified, which means that increased interoperability with other DLNA certified 
devices. The software also enables advanced digital rights management, an auto 
setup wizard, and auto-generating video thumbnails. Mediabolic’s Embedded 
Media Server makes accessing, sharing, and enjoying your media files easy.  
 
To set up the Media Server, refer to Chapter 4: Additional Feature Setup > 
Media Server. 
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iTunes® Server 
Digital music is one of the hottest trends, and with the built-in iTunes® server, 
you can share your digital music files with every iTunes-equipped PC on your 
network. The iTunes Server is also incredibly easy to set up!  
 
To set up the iTunes Server, refer to Chapter 4: Additional Feature Setup > 
iTunes Server. 

Photo Gallery 
The Photo Gallery is a great way for friends and family to share precious 
memories of vacations, birthdays, and more. Users can upload pictures, and even 
create their own picture albums right on the N1200. 
 
To set up the Photo Gallery, refer to Chapter 5: Using the M3800 > Using 
Photo Gallery. 

Web Cam Server 
With the M3800’s Web Cam server, you can schedule the M3800 to capture 
images from a connected USB webcam at designated intervals.  
 
To set up the Web Cam Server, refer to Chapter 5: Additional Feature Setup 
> Web Cam Server. 

Printer Server 
With the M3800’s Printer Server, you can easily share an IPP printer with other 
PCs connected to your network.  
 
To set up the Printer Server, refer to Chapter 5: Additional Feature Setup > 
Printer Server. 

Superior Power Management 
M3800 supports schedule power on/off. With this feature, administrator can set at 
what time to turn on or off the system. This feature is a big plus for people who 
want to conserve energy.  
 
To schedule system on and off, refer to Chapter 4: System Management > 
System Settings > Reboot and Shutdown System > Scheduled Power 
On/Off. 
 

Package Contents 
Your M3800 package should contain the following items: 
 

 Thecus M3800 IP Storage Appliance 
 QIG 
 CD-Title 
 Ethernet Cable 
 Hard drive rails (located behind front panel) 
 Remote Control 
 AV cable x 2 

 
Please check to see if your package is complete. If you find that some items are 
missing, contact your dealer. 



Front Panel 
The Thecus M3800’s front panel has the device’s controls, indicators, and hard 
disk trays: 
 

 
Front Panel 
Item Description 
OSD LED • Solid blue: system is OSD on 
WAN LED 
 

• Solid green: network link 
• Blinking orange: network activity 

LAN LED 
 

• Solid green: network link  
• Blinking orange: network activity 

HDD 1 LED • Solid red: HDD failure 
• Blinking orange: HDD activity 

HDD 2 LED • Solid red: HDD failure 
• Blinking orange: HDD activity 

HDD 3 LED • Solid red: HDD failure  
• Blinking orange: HDD activity 

USB Port 
 

• USB 2.0 port for compatible USB devices, such as digital 
cameras, USB disks, USB printers, and USB wireless dongles* 

 
Note: For supported USB wireless dongles, please contact 
support@thecus.com 

Power Button • Power on/off M3800 
• Solid blue: Device is powered on 

LCD Display • Displays current system status and messages (Update time: 60 
seconds). 

Down Button ▼ • Push to scroll DOWN when using the LCD display 
Up Button ▲ • Push to scroll UP when using the LCD display 

Enter Button ↵ • Push to confirm information entered into the LCD display 

Escape Button ESC • Push to leave the current LCD menu 
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Rear Panel 
The Thecus M3800’s rear panel features ports and connectors. 
 

 
 
 

Back Panel 
Item Description 
eSATA Port • eSATA port for high-speed storage expansion 
USB Port • USB 2.0 port for compatible USB devices, such as digital 

cameras, USB disks, and USB printers 
WAN Port • WAN port for connecting to an Ethernet network through a 

switch or router 
LAN Port • LAN port that can be used for connection sharing 
PCI Slot • Reserved for future Thecus proprietary expansion 
System Fan • System fan that exhausts heat from the unit 
Power Connector • Connect the included power cords to these connectors 
Reset Button 
 
 

• Resets the M3800 
• immediately press and hold the Reset button on the back for 5 

seconds. This will reset your network setting, password, and 
turn off Jumbo Frame Support. 
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Chapter 2: Hardware Installation 

Overview 
Your M3800 is designed for easy installation. To help you get started, the 
following chapter will help you quickly get your M3800 up and running. Please 
read it carefully to prevent damaging your unit during installation. 

Before You Begin 
Before you begin, be sure to take the following precautions: 
 

1. Read and understand the Safety Warnings outlined in the beginning of 
the manual. 

 
2. If possible, wear an anti-static wrist strap during installation to prevent 

static discharge from damaging the sensitive electronic components on the 
M3800. 

 
3. Be careful not to use magnetized screwdrivers around the M3800’s 

electronic components. 

Hard Disk Installation 
The M3800 supports three standard 3.5” Serial ATA (SATA) hard disks. To install 
a hard disk into the M3800, follow the steps below: 
 

1. Remove the front panel of the M3800. 
 
2. Unscrew the thumbscrews which are securing the hard drive rails. 

 
3. Remove the hard drive rails and install them to your SATA hard disk(s). 

 
4. Slide hard disks into the M3800 until they snap into place. 

 
5. Replace the thumbscrews. 

 
6. Replace the M3800 front cover. 

 

NOTE  If your HDD was part of a RAID 1 or 5 array previously, it automatically rebuilds. If 
you replace all the drives with higher capacity drives, you need to go to 
Administrator login and format the drives.  
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Cable Connections 
To connect the M3800 to your network, follow the steps below: 
 

1. Connect an Ethernet cable from your network to the WAN port on the back 
panel of the M3800. 
 

 
 
2. Connect the provided power cord into the power socket on the back panel. 

Plug the other end of the cord into a surge protector socket.  
 

 
 

3. Press the power button on the Front Panel to boot up the M3800. 
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Chapter 3: First Time Setup 

Overview 
Once the hardware is installed, physically connected to your network, and 
powered on, you can configure the M3800 so that it is accessible to your network 
users. Follow the steps below for initial software setup. 

Thecus Setup Wizard 
The handy Thecus Setup Wizard makes configuring M3800 a snap. To configure 
the M3800 using the Setup Wizard, perform the following steps: 
 

1. Insert the installation CD into your CD-ROM drive (the host PC must be 
connected to the network). 

 
2. The Setup Wizard should launch automatically. If not, please browse your 

CD-ROM drive and double click on Setup.exe. 
 

 
 
 
 
 
 

 

NOTE 
 
For MAC OS X users, double click on Thecus Setup Wizard 1.

 
 1.99.dmg 

 
 

3. The Setup Wizard will start and automatically detect all Thecus storage 
devices on your network. If none are found, please check your connection 
and refer to Chapter 8: Troubleshooting for assistance. 

 

 
 

4. Select the M3800 that you like to configure. Press Next to continue. 
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5. Login with the administrator account and password. The default account 
and password are both “admin”. Press Next to continue. 

 

 
 

6. Name your M3800 and configure the network IP address. If your switch or 
router is configured as a DHCP Server, configuring the M3800 to 
automatically obtain an IP address is recommended. You may also use a 
static IP address and enter the DNS Server address manually. Press Next 
to continue. 

 

 
 

7. Enable the desired services. Press Next to continue. 
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8. Select the RAID level you wish to use. Press Next to continue. 
 

 
 

9. Change the default administrator password. 
 

 
 

10. Access the M3800 Web Administrator Interface by pressing the Start 
Browser button. You can also configure another M3800 at this point by 
clicking the Setup Other Device button. Press Exit to exit the wizard. 

 

 
 

The Thecus Setup Wizard is designed for installation on systems running Windows 
XP/2000 or Mac OSX or later. Users with other operating systems will need to install 
the Thecus Setup Wizard on a host machine with one of these operating systems 
before using the unit.  

NOTE 
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RAID Setup and Firmware Installation 
Once the setup wizard has completed, you should now be inside the Web Admin 
Interface. From here, it is time to initialize your RAID system and install the 
firmware for the M3800. 
 

The next steps are for first time setup only. If you have previously setup your 
M3800, you can skip this section of the setup process. NOTE  

 
 

Setting up the RAID 
 

1. From the Web Admin Interface, navigate to Storage > RAID. The RAID 
Information screen appears. 

 

 
 
 Click Config. 
 
2. Select your desired RAID level, and check the checkboxes of the disks you 

wish to use in your array. 
 

 
 

3. Select a stripe size – the default is 64K. 
4. Click Create to create your selected RAID volume. 
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LCD Operation 
The M3800 is equipped with an LCD on the front for easy status display and setup. 
There are four buttons on the front panel to control the LCD functions. 

LCD Controls 
Use the Down (▼), Up (▲), Enter (↵) and Escape (ESC) keys to select various 
configuration settings and menu options for M3800 configuration.  
 
The following table illustrates the keys on the front control panel: 
 
LCD Controls 
Icon Function Description 
▼ Down Button Select the previous configuration settings option. 
▲ Up Button Select the next configuration settings option. 
↵ Enter Enter to display USB copy operation. 
ESC Escape Escape to give up USB copy. 

Press and hold for 3 seconds to turn off the LCD’s backlight. 
Press any button to switch the backlight back on. 

Display Mode 
During normal operation, the LCD will be in Display Mode. 
 
Display Mode 
Item Description 
Host Name Current host name of the system. 
WAN Current WAN IP setting.  
LAN Current LAN IP setting. 
RAID Current RAID status. 
System Fan Current system fan status. 
Temperature Current system temperature. 
Date/Time Current system date and time 
Up Time The system power on time since last start 

 
The M3800 will rotate these messages every three seconds on the LCD display. 

If the RAID array is in a degraded state, the LCD display will be stopped in display 
mode and show which disk is degraded in the array: 
 RAID: Degraded [Disk #] 

NOTE 

 

 

USB Copy 
The USB Copy function enables you to copy files stored on USB devices such

 disks and digital cameras to the M3800 with a press of a button. To use
 as 

US  USB 
copy, 

the Front Panel. 

2. In Displ e, press the Enter (↵). 

4. Press Enter (↵) and the M3800 will start copying USB disks connected to 
the front USB port. The LCD will display the USB copy progress and results. 

B
follow the steps below: 

 
1. Plug your USB device into an available USB port on 
 

 ay Mod
 

3. The LCD will display “USB Copy?”  
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Typical Setup Procedure 
From the Web Administration Interface, you can begin to setup your M3800 for 
se on your network. Setting up the M3800 typically follows the five steps 

For more on how to use the Web Administration Interface, see Chapter 4: 
Web Administration Interface. 

the Web Administration Interface, you can configure the network settings of 
e M3800 for your network. You can access the Network menu from the menu 

For details on how to configure your network settings, refer to Chapter 4: 
Network Management. 

g and build their 
AID volume. You can access RAID settings from the menu bar of the Web 

or more information on configuring RAID, see Chapter 4: System 

Don’t know which RAID level to use? Find out more about the different RAID 

nce the RAID is ready, you can begin to create local users for the M3800, or 

or more on managing users, go to Chapter 4: System Management > User 

or more information on configuring Active Directory, see Chapter 4: System 

For information about the benefits of Active Directory, see Appendix D: Active 

sers are introduced into your network, you can begin to create various 
lders on the M3800 and control user access to each using Folder Access Control 

ore information on managing folders, see Chapter 4: System Management > 

To find out about configuring Folder Access Control Lists, see Chapter 4: System 
Management > Folder Management > Folder Access Control List (ACL). 

u
outlined below. 
 

System Management > 

Step 1: Network Setup 
From 
th
bar.  
 

System Management > 

Step 2: RAID Creation 
Next, administrators can configure their preferred RAID settin
R
Administration Interface by navigating to Storage > RAID. 
 
F
Management > RAID Configuration. 
 

levels from Appendix C: RAID Basics. 

Step 3: Create Local Users or Setup Authentication 
O
choose to setup authentication protocols such as Active Directory (AD). 
 
F
and Group Management. 
 
F
Management > User and Group Management > ADS/NT Configuration. 
 

Directory Basics. 

Step 4: Create Folders and Set Up ACLs 
Once u
fo
Lists.  
 
M
Folder Management. 
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Step 5: Start Services 
Finally, you can start to setup the different services of the M3800 for the users on 
your network. You can find out more about each of these services by clicking 
below: 
 
Windows Networking (SMB/CIFS) iTunes® Server 
 
Apple File Protocol (AFP)   Media Server 
 
Network File System (NFS)  Web Cam Server 
 
File Transfer Protocol (FTP)  Printer Server 



Chapter 4: System Management 

Overview 
The M3800 provides an easily accessible Web Administration Interface. With it, 
you can configure and monitor the M3800 anywhere on the network. 
 

Web Administration Interface 
Make sure your network is connected to the Internet. To access the M3800 Web 
Administration Interface: 
 

1. Type the M3800’s IP address into your browser. (Default IP address is 
http://192.168.1.100)   

 
 

Your computer’s network IP address must be on the same subnet as the M3800. If 
the M3800 has default IP address of 192.168.1.100, your managing PC IP address 
must be 192.168.1.x, where x is a number between 1 and 254, but not 100. 

NOTE  
 
 
 

2. Login to the system using the administrator user name and password. The 
factory defaults are:  

 
User Name: admin 
Password: admin 
 
If you changed your password in the setup wizard, use the new password. 

 
Once you are logged in as an administrator, you will see the Web 
Administration Interface. From here, you can configure and monitor virtually 
every aspect of the M3800 from anywhere on the network. 
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Menu Bar 
The Menu Bar is where you will find all of the information screens and system 
settings of the M3800. The various settings are placed in the following groups on 
the menu bar: 
 

 
 
Menu Bar 
Item Description 
Status Current system status of the M3800. 
Storage Information and settings for storage devices installed into the 

M3800.  
Network Information and settings for network connections, as well as 

various services of the M3800. 
Accounts Allows configuration of users and groups. 
System Various M3800 system settings and information. 
Language Choose your preferred language here. 

 
Moving your cursor over any of these items will display the dropdown menu 
selections for each group. 
 
In the following sections, you will find detailed explanations of each function, and 
how to configure your M3800. 
 
 

Language Selection 
The M3800 supports multiple languages, 
including: 
 

• English 
• French 
• German 
• Italian 
• Traditional Chinese 
• Simplified Chinese 
• Japanese 
• Korean 
• Spanish 

 
On the menu bar, click Language and the Change Language screen appears. 
This screen allows you to select preferred language for the M3800. Press Apply 
to confirm your selection. 
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Status Menu 
The Status Menu on the menu bar allows you to see various aspects of the 
M3800. From here, you can discover the status of the M3800, and even find out 
other details like firmware version and up time.  

Product Information 
Once you login, you will first see the basic 
Product Information screen providing 
Manufacturer, Product No., Firmware 
Version, and Up Time information. 
 
 
 
 
 
 
 
 
 
 
 
Product Information 
Item Description 
Manufacturer Displays the name of the system manufacturer. 
Product No. Shows the model number of the system. 
Firmware version Shows the current firmware version. 
APP version Shows the current application pack version. 
Up time Displays the total run time of the system. 

 
To access this screen again, navigate to Status > About. 

System Status 
From the Status menu, choose the System 
item, and the System Status screen 
appears. These screens provide basic 
system status information. 
 
 
 
 
 
 
 
 
 
 
 
System Status 
Item Description 
CPU Loading (%) Displays current CPU workload of the M3800. 
Fan RPM Displays the current speed of the system fan. 
Up Time Shows how long the system has been running. 
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Printer Status 
From the Status menu, choose the Printer 
item, and the Printer Information screen 
appears. This screen provides the following 
information about the USB printer 
connected to the USB port. 
 
 
 
 
 
 
 
 
 
 
 
Printer Status 
Item Description 
Manufacturer Displays the name of the USB printer manufacturer. 
Model Displays the model of the USB printer. 
Status Displays the status of the USB printer. 
Printer Queue Click to remove all documents from printer queue 

 
If a corrupt print job is sent to a printer, printing may suddenly fail. If your print 
jobs seem to be locked up, pressing the Remove All Documents button to clear 
the print queue may resolve the issue. 
 
For information on how to set up the Printer Server, refer to Chapter 5: 
Additional Feature Setup > Printer Server. 
 

Wake-Up On Lan (WOL) 
The M3800 has the ability to be awoken 
from sleep mode via WAN or LAN.  
 
From the Status menu, choose the WOL 
item, and the Wake-up On Lan 
Configuration screen appears. From here, 
you can Enable or Disable Wake-up On 
WAN and Wake-up On LAN. 
 
 
Wake-up On Lan Configuration 
Item Description 
WAN Enable or Disable Wake-up On WAN. 
LAN Enable or Disable Wake-up On LAN. 
Apply Click Apply to save changes. 
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Storage Management 
The Storage Menu displays the status of storage devices installed in the M3800, 
and includes storage configuration options such as RAID and disk settings, folder 
configuration settings.  

SATA Information 
From the Storage menu, choose the SATA 
item and the Disks Information screen 
appears. From here, you can see various 
items about installed SATA hard disks. Blank 
lines indicate that a SATA hard disk is not 
currently installed in that particular disk slot. 
If there is a problem with a disk, a Failed 
message will be displayed in the Status 
column.   
 
 
 
 
 
 
Disks Information 
Item Description 
Disk No. Indicates disk location. 
Capacity Shows the SATA hard disk capacity. 
Model Displays the SATA hard disk model name. 
Firmware Shows the SATA hard disk firmware version. 
Status Indicates the status of the disk. Can read OK, Warning, or 

Failed. 
Total Capacity Shows the total SATA hard disk capacity. 
Disk Power 
Management 

The administrator can set the disk to power down after a period 
of inactivity. 

NOTE 
When the Status shows Warning, it usually means there are b
disk. It is shown only as a precaution and you should consi

 ad sectors on the hard 
der changing the drives. 

 
 

eSATA Information 
From the Storage menu, choose the 
eSATA item and the eSATA Information 
screen appears. From here, you can see 
various items about the eSATA hard disk 
connected to the M3800, including capacity, 
used percentage, and model and firmware 
version. You can even format the connected 
eSATA hard disk from this menu.  
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eSATA Information 
Item Description 
Model Displays the eSATA hard disk model name. 
Capacity Shows the eSATA hard disk capacity in megabytes (MB). 
Used Percentage Shows the capacity remaining on the eSATA hard disk in 

percentage (%) and megabytes (MB). 
Firmware Shows the eSATA hard disk firmware version. 
Format Press Format to format your eSATA hard disk. 
Eject Press Eject to unmount the eSATA hard disk. 

Formatting will destroy all data on your eSATA hard disk. This data is not 
recoverable. WARNING  

 

USB Disk Information 
From the Storage menu, choose the USB 
item and the USB Information screen 
appears. From here, you can see various 
items about USB disks connected to the 
M3800.  
 
 
 
 
 
 
 
 
 
 
USB Information 
Item Description 
Disk No. Number assigned to each USB disk. 
Capacity (MB) Shows the capacities of each USB disk in megabytes (MB). 
Model Displays the model names of each USB disk. 
Firmware Shows the firmware version of each USB disk. 
Status Shows the status of each USB disk. An Eject button appears 

beside each USB disk. Press this button before removing the 
USB disk. 

Refresh Press Refresh to rescan the status of the USB disks. 
 

RAID Information 
From the Storage menu, choose the RAID 
item and the RAID Information screen 
appears.  
 
This screen lists the RAID volume currently 
residing on the M3800. From this screen, 
you can get information about the status of 
your RAID volume, as well as the status, 
used percentage, and stripe size. 
 
To configure your RAID settings, press the 
Config button to go to the RAID 
Configuration screen. 
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RAID Information 
Item Description 
RAID Level Shows the current RAID configuration. 
Total Capacity Total capacity of the current RAID. 
Status Indicates status of the RAID. Can read either Healthy, 

Degraded, or Damaged. 
Used Percentage Indicates total percentage used of the RAID volume. 
Stripe Size Indicates the current stripe size being used. 
Remaining Time Indicates the time remaining until the RAID volume is built. 
Config Press this to configure RAID volumes. 

RAID Configuration 
On the RAID List screen, press the RAID 
Config button to go to the RAID 
Configuration screen. In addition to RAID 
disk information and status, this screen lets 
you make RAID configuration settings.  
 
For more information on RAID, see 
Appendix C: RAID Basics. 
 
 
 
 
 

RAID Level 
You can set the storage volume as JBOD, RAID 0, RAID 1, or RAID 5. RAID 
configuration is usually required only when you first set up the device. A brief 
description of each RAID setting follows: 
 
RAID Levels 
Level Description 
JBOD The storage volume is a single HDD with no RAID support. JBOD 

requires a minimum of 1 disk. 
RAID 0 Provides data striping but no redundancy. Improves 

performance but not data safety. RAID 0 requires a minimum of 
2 disks. 

RAID 1 Offers disk mirroring. Provides twice the read rate of single 
disks, but same write rate. RAID 1 requires a minimum of 2 
disks. 

RAID 5 Data striping and stripe error correction information provided. 
Excellent performance and good fault tolerance. RAID 5 requires 
a minimum of 3 disks. RAID 5 can sustain one failed disk. 

 
WARNING 

If the administrator improperly removes a hard disk that should not be removed 
when RAID status is Degraded, all data will be lost. 
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RAID Settings 
Using RAID Settings, you can select stripe size, choose which disks are RAID 
disks or the Spare Disk, as well as enter a name for each disk. 
 
RAID Settings 
Item Description 
Disk No. Number assigned to the installed hard disks. 
Capacity (MB) Capacity of the installed hard disks. 
Model Model number of the installed hard disks. 
RAID Check the boxes of the hard drives you wish to add to the 

storage volume. 
Spare If this is checked, current hard disk is designated as a spare for 

a RAID volume. 
Stripe Size This sets the stripe size to maximize performance of sequential 

files in a storage volume. Keep the 64K setting unless you 
require a special file storage layout in the storage volume. A 
larger stripe size is better for large files. 

Create RAID Press this button to configure a file system and create the RAID 
storage volume. 

Remove RAID Click to remove the RAID volume. All user data, iSCSI, and 
Target USB data will be removed. 

Cancel Press this button to exit without saving changes. 

Creating a RAID 
To create a RAID volume, follow the steps below: 
 

1. On the RAID Configuration screen, set the RAID storage space as JBOD, 
RAID 0, RAID 1, or RAID 5, — see Appendix C: RAID Basics for a 
detailed description of each. 

2. Tick the checkboxes of the hard disks you wish to use to create a RAID.  
3. Specify a stripe size — 64K is the default setting.  
4. Press Create to build the RAID storage volume. 

 
NOTE 

Building a RAID storage space may take time, depending o
and RAID mode. 

n the size of hard drives 
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WARNING 

 
Creating RAID destroys all data in the current RAID. The data is unrecoverable.  

 
 
With a RAID 1 volume, you can also add a spare disk after the RAID is created. 
See Chapter 7: Tips and Tricks > Adding a Spare Disk for details. 

Deleting a RAID 
To delete a RAID volume, follow the steps below: 
 

1. On the RAID List screen, select the RAID volume by clicking on its radio 
button, and click Config to open the RAID Configuration screen. 

2. On the RAID Configuration screen, click Remove. 
3. The system automatically rebuilds and you can create a new RAID.  

 
 
Removing RAID destroys all data in the current RAID. The data is unrecoverable.  WARNING 

 
 



Folder Management 
From the Storage menu, choose Folder, 
and the Folder screen appears. This screen 
allows you to create and configure folders 
on the M3800 volume. 
 
 
 
 
 
 
 
 
 
 
 
Folder 
Item Description 
Folder name Displays the name of the folder. 
Description Provides a description of the folder. 
NFS Share Press NFS Share to configure which hosts on the network are 

allowed to access this folder using NFS. 
ACL Press ACL (Access Control List) to configure which users have 

access to this folder. 
Edit Press Edit to enter the Edit screen and modify the folder’s 

name and description. 
Del Press Del to delete the folder. A prompt appears asking to 

confirm the deletion. 
Add Press Add to enter the Add Folder screen. 

 

Adding Folders 
On the Folder screen, press the Add button 
and the Add Folder screen appears. This 
screen allows you to add a folder. After 
entering the information, press Apply to 
create new folder. Press Back to return to 
the Folder screen. 
 
 
 
 
 
 
 
 
Add Folder 
Item Description 
Folder Name Enter the name of the folder. 
Description Provide a description the folder. 
Browseable Enable or disable users from browsing the folder contents. If 

Yes is selected, then the share folder will be browseable. 
Public Admit or deny public access to this folder. If Yes is selected, 

then users do not need to have access permission to write to 
this folder. When accessing a public folder via FTP, the behavior 
is similar to anonymous FTP. Anonymous users can 
upload/download a file to the folder, but they cannot delete a 
file from the folder. 
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Apply Press Apply to create the folder. 
Back Press Back to return to the Folder screen. 

 
Folder names are limited to 60 characters. Systems running Windows 98 or earlier 
may not support file names longer than 15 characters. NOTE  

 
 

Editing Folders 
On the Folder screen, press the Edit button and the Edit Folder screen appears. 
This screen allows you to change folder information. After entering the 
information, press Submit to apply the changes. Press Back to return to the 
Folder screen. 
 
Edit Folder 
Item Description 
Share Name Enter the name of the (Share) folder. 
Description Provide a description the folder. 
Browseable Enable or disable users from browsing the folder contents. 
Public Admit or deny public access to this folder. 
Submit Press Submit to save your changes. 
Back Press Back to return to the Folder screen. 

Deleting Folders 
To delete a folder, press the Del button from the specified folder row. The system 
will confirm folder deletion. Press OK to delete the folder permanently or Cancel 
to go back to the folder list. 
 

All the data stored in the folder will be deleted once the folder is deleted. The data 
will not be recoverable. WARNING 

 
 
 

NFS Share 
To allow NFS access to the share folder, enable the NFS Service, and then set up 
hosts with access rights. Click Add to access the New NFS Share dialogue. 
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Add 

 
NFS Share 
Item Description 
Hostname Enter the name of the Host or IP address 
Privilege Host has either read only or writeable access to the folder. 
Access as Access the data as a Root User or an Anonymous User. 
Apply Click to save your changes. 
Back Click to exit without saving changes. 

 



Folder Access Control List (ACL) 
On the Folder screen, press the ACL button, 
and the Access Control List screen 
appears. This screen allows you to configure 
access to the specific folder for users and 
groups. Select a user or a group from the 
left hand column and then choose Deny, 
Read Only, or Writable to configure their 
access level. Press the Submit button to 
confirm your settings. 
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Access Control List 
Item Description 
Deny Denies access to users or groups who are displayed in this 

column. 
Read Only Provides Read Only access to users or groups who are displayed 

in this column. 
Writable Provides Write access to users or groups who are displayed in 

this column. 
Remove Removes the selected user or group from the column in order to 

reset their access privileges. 
Submit Submits and confirms settings. 
Reset Cancel your settings and return to the Folder screen.  

 
To configure folder access, follow the steps below: 
 

1. On the ACL screen, all network groups and users are listed in the left hand 
column. Select a group or user from this list. 

 
2. With the group or user selected, press one of the buttons from the three 

access level columns at the top. The group or user then appears in that 
column and has that level of access to the folder.  

 
3. Continue selecting groups and users and assigning them access levels 

using the column buttons. 
 

4. To remove a group or user from an access level column, press the 
Remove button in that column. 

5. When you are finished, press Submit to submit and confirm your ACL 
settings. 

 



Network Management 
Use the Network menu to make network configuration settings as well as service 
support settings. 

WAN Configuration 
From the Network menu, choose WAN, and 
the WAN Configuration screen appears. 
This screen displays the network parameters 
of the WAN connection. You may change any 
of these items and press Apply to confirm 
your settings. See a description of each item 
in the following table: 
 
 
 
 
 
 
 
WAN Configuration 
Item Description 
Host name Host name that identifies the M3800 on the network. 
Domain name Specifies the domain name of the M3800. 
MAC Address MAC address of the network interface. 
Jumbo Frame Support Enable or disable Jumbo Frame Support of the WAN interface on 

your M3800. 
WAN Port Enable or disable the M3800 from obtaining in IP address via 

DHCP server. If you require a static IP, disable this feature and 
input your network configuration. 

IP IP address of the WAN interface. 
Netmask Network mask, which is generally: 255.255.255.0 
Gateway Default Gateway IP address. 
DNS Server Domain Name Service (DNS) server IP address. 
IP Sharing Mode When enabled, PCs connected to the LAN port will be able to 

access the WAN. Default is Enabled. 
 
 

• A correct DNS setting is vital to networks services, such as SMTP and NTP. 

• Enabling DHCP automatically turns on UPnP—see the Service Support Screen. 
• If you are only using the WAN port, we suggest that you disable IP Sharing 

Mode. This will result in higher throughput. 

• Only use Jumbo Frame settings when operating in a Gigabit environment where 
all other clients have Jumbo Frame Setting enabled. NOTE  

 
 
 
 
 

Most Fast Ethernet (10/100) Switches/Routers do not support Jumbo Frame and 
you will not be able to connect to your M3800 after Jumbo Frame is turned on. If 
this happens, turn off the M3800. Then, power on the M3800 and immediately 
press and hold the Reset button on the back of the unit for 5 seconds. This will 
reset your network settings, password, and turn off Jumbo Frame Support. 

WARNING  
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LAN Configuration 
The M3800 supports two Gigabit Ethernet 
ports for higher service availability. To 
configure these ports, choose LAN from the 
Network menu, and the LAN 
Configuration screen appears. Press 
Apply to save your changes. 
 
 
 
 
 
 
 
 
 
LAN Configuration 
Item Description 
MAC Address Displays the MAC address of the LAN interface. 
Jumbo Frame Support Enable or disable Jumbo Frame Support on the LAN interface. 
IP Specifies the IP address of the LAN interface. 
Netmask Specifies the Network Mask of the LAN interface. 

 
Before enabling Jumbo Frame Support, please make sure your network equipment 
supports Jumbo Frame. If your equipment is incompatible, you might not be able to 
connect to your M3800. In this case, you have to reset the system back to default 
by the holding down front panel reset button for 5 seconds during boot up process. 

NOTE 
 
 
 
 

DHCP Configuration 
A DHCP server can be configured to assign IP addresses to devices connected to 
the LAN port. To configure these ports, choose LAN from the Network menu. 
 
DHCP Configuration 
Item Description 
DHCP Server Enable or disable the DHCP server to automatically assign IP 

address to PCs connected to the LAN interface. 
Start IP Specifies the starting IP address of the DHCP range. 
End IP Specifies the ending IP address of the DHCP range. 
DNS Server Specifies the DNS server IP address. 

 

The IP address of the LAN interface should not be in the range of the Start IP 
address and End IP address. WARNING 

 
The IP Segment of WAN and LAN should not overlap. NOTE 
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WLAN Configuration 
When a compatible wireless USB dongle is 
installed on the M3800, the M3800 will 
become an access point, and the Network 
dropdown menu will contain a WLAN menu 
item. From the Network menu, choose 
WLAN, and the WLAN Configuration 
screen appears. This screen displays the 
wireless network parameters of the system. 
You can to change any of these items and 
press Apply to confirm your settings.  
 
 
 
 
 
 

• USB dongles have to be connected 
before the M3800 is powered up. 

• Currently supported USB wireless 
dongles are: 3Com 3CRUSB10075, 
Zyxel G220USB, PCI GW-US54mini.  

NOTE 

 
 
 
 
 
 
WLAN Configuration 
Item Description 
MAC Address Displays the MAC Address of the USB wireless dongle. 
IP Specifies the IP address of the network connection. 
Netmask Specifies the network mask, which is generally: 255.255.255.0 
ESSID The ESSID (Extended Service Set Identification) is the 

identifying name of a wireless network. 
ESSID Broadcast Specifies whether the ESSID will be broadcasted by the M3800. 

This will prevent the Access Point from broadcasting the ESSID. 
The M3800 will still respond to a wireless device that wants to 
communicate if it sends a matching ESSID. 

Channel The channel that the M3800 uses to communicate with client 
devices. 

Auth Mode Authentication mode used by the M3800. 
Shared: Shared key authentication 
Open: Open key authentication 

WEP Enable Specifies whether to use encryption for transmission or not. 
Key Length Key length specifies the level of encryption used by the M3800. 

64 bit: 10 characters from 0 ~ 9 and A ~ F. 
128 bit: 26 characters from 0 ~ 9 and A ~ F. 

WEP KEY 1 
WEP KEY 2 
WEP KEY 3 
WEP KEY 4 

Input up to 4 WEP keys, and select the one you wish to use. 
When connecting, be sure to enter the same key and select the 
same index number on each client machine. 

 
A DHCP server can be configured to assign IP addresses to devices connected to 
LAN ports. 
 
WLAN DHCP Configuration 
Item Description 
DHCP Server Select to enable or disable DHCP server. 
Start IP Specifies the starting IP address of the DHCP range. 
End IP Specifies the ending IP address of the DHCP range. 
DNS Server Specifies the DNS server IP address. 
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NOTE 
 
The IP Segment of WLAN, WAN and LAN should not overlap. 

 
 
 
 

4  France 

13  Europe (ETSI)  
2  Spain  

14  Japan  

 
11  N. America  

Users should obey the international RF regulatory rules as they set up the wireless 
RF channel on the M3800. The RF operating channels for different regions have 
been specified as following. Thecus has no responsibility for users attempting to 
violate the international RF regulation. 

NOTE  
 
 
 
 
 
 

DDNS Configuration 
From the Network menu, choose the DDNS 
item, and the DDNS Support screen 
appears. You can change any of these items 
and press Apply to confirm your settings. A 
description of each item follows: 
 
 
 
 
 
 
 
 
 
 
DDNS Support 
Item Description 
DDNS Enable or disable DDNS support. 
Register Enter your desired DDNS server here. 
User Name Enter your user name. 
Password Enter your password or DDNS key. 
Domain Name Enter your host name (i.e. www.M3800.dyndns.org) 
Apply Click to save your changes. 

 

Typical DDNS Configuration Procedure 
To setup DDNS on your M3800, follow the steps below: 
 

1. Go to http://www.dyndns.org from your home PC. 
2. Click on the Sign Up Now link. 
3. Check the check boxes, select a user name (i.e.: M3800), enter your email 

address (i.e.: xxx@example.com), check Enable Wildcard, and create a 
password (i.e.: xxxx). 

4. Wait for an email from www.dyndns.org. 
5. Open the email and click on the link to activate your account. 
6. Once your account is activated, enter the DDNS server, user name, 

password, and host name into the DDNS Support screen. 
7. Click Apply to save your changes. 
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Web Services Configuration 
From the Network menu, choose the 
Service item, and the Web Service screen 
appears. This screen displays the service 
support parameters of the system. You can 
change any of these items and press Apply 
to confirm your settings. A description of 
each item follows: 
 
 
 
 
 
 
 
 
 
 
Web Service 
Item Description 
HTTP (WebDisk) 
Support 

Enable or disable WebDisk support. Enter the port number if this 
option is enabled. 

HTTPs (Secure 
WebDisk) Support 

Enable or disable secure WebDisk support. Enter the port if this 
option is enabled. 

UPnP Enable or disable Universal Plug and Play protocol. UPnP helps to 
find the IP address of the M3800. 

AFP (Apple Network Setup) 
From the Network menu, choose the AFP 
item, and the AFP Configuration screen 
appears. This screen displays the 
configuration items for the Apple Filing 
Protocol. You can change any of these items 
and press Apply to confirm your settings. A 
description of each item follows: 
 
 
 
 
 
 
 
 
Apple Network Configuration 
Item Description 
AFP Server Enable or disable Apple File Service to use the M3800 with MAC 

OS-based systems. 
MAC CHARSET If your operating system does not support Unicode (e.g. MAC 

OS9/8), select the same language as your OS here in order to 
properly view the files and directories on the server. 

Zone Specifies Zone for Applet Talk service. 
If your AppleTalk network uses extended networks and is 
assigned with multiple zones, assign a zone name to the M3800. 
If you do not want to assign a network zone, enter an asterisk 
(*) to use the default setting. 

 

Disable HTTP support and Enable 
Secure HTTP support to guarantee 
secure access. 

NOTE 
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NFS Setup 
From the Network menu, choose the NFS 
item, and the NFS Support screen appears. 
The M3800 can act as an NFS server, 
enabling users to download and upload files 
with their favorite NFS clients. Press Apply 
to confirm your settings. A description of 
each item follows: 
 
 
 
 
 
 
 
 
NFS Support 
Item Description 
NFS Enable or Disable NFS support. 
Apply Click Apply to save your changes. 
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User and Group Management 
The M3800 has built-in user database that allows administrators to manage user 
access using different group policies. From the Accounts menu, you can create, 
modify, and delete users, and assign them to groups that you designate.  

Local User Configuration 
From the Accounts menu, choose the 
Users item, and the Local User 
Configuration screen appears. This screen 
allows you to Add, Modify, and Delete 
local users.  
 
 
 
 
 
 
 
 
 
 
Local User Configuration 
Item Description 
Add Press the Add button to add a user to the list of local users. 
Modify Press the Modify button to modify a local user. 
Delete Press the Delete button to delete a selected user from the 

system. 

Adding Users 
 
1. Click on the Add button on Local 

User Configuration screen, and 
Local User Setting screen appears. 
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2. On the Local User Setting screen, 

enter a name in the User Name box. 
 

3. Enter a password in the Password 
box and re-enter the password in the 
Confirm box. 

 
4. Select which group the user will 

belong to. Group Members is a list 
of groups this user belongs to. 
Group List is a list of groups this 
user does not belong to. Use the << or >> buttons to have this user join 
or leave a group. 

 
5. Press the Apply button and the user is created. 

 

All users are automatically assigned to the ‘users’ group. 
 

NOTE 
 
 
 



Modifying Users 
 

1. Select an existing user from the Local User Configuration screen. 
 
2. Click on the Modify button, and Local User Setting screen appears. 

 
3. From here, you can enter a new password and re-enter to confirm, or use 

the << or >> buttons to have this user join or leave a group. Click the 
Apply button to save your changes. 

 

Deleting Users 
 
1. Select an existing user from the Local User Configuration screen. 
 
2. Click on Delete button and the user is deleted from the system. 

 
 

Local Groups Configuration 
From the Accounts menu, choose the Groups item, and the 
Local Groups Configuration screen appears. This screen 
allows you to Add, Modify, and Delete local groups. 
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Local Groups Configuration 
Item Description 
Add Press the Add button to add a user to the list of local groups. 
Modify Press the Modify button to delete a selected group from the 

system. 
Delete Press the Delete button to delete a selected group from the 

system. 

Adding Groups 
 
1. On the Local Group Configuration screen, click on the Add button. 
 
2. The Local Group Setting screen appears. 

 
3. Enter a Group Name, and select users to be in this group from the Users 

List by adding them to the Members List using the << button.  

4. Click the Apply button to save your changes.  
 



Modifying Groups 
 

1. On the Local Group Configuration 
screen, select a group name from the 
list. 

 
2. Press the Modify button to modify 

the members in a group. 
 

3. To add a user into a group, select the 
user from the Users List, and press 
the << button to move the user into 
the Members List. 

 
4. To remove a user from a group, 

select the user from Members List, 
and press the >> button. 

 
5. Click the Apply button to save your changes. 

Deleting Groups 
 
1. On the Local Group Configuration screen, select a group name from the 

list. 
 

2. Press Delete to delete the group from the system. 
 
 

ADS/NT Configuration 
If you have a Windows Active Directory 
Server (ADS) or Windows NT server to 
handle the domain security in your network, 
you can simply enable the ADS/NT support 
feature; the M3800 will connect with the 
ADS/NT server and get all the information of 
the domain users and groups automatically. 
From the Accounts menu, choose 
Authentication item and the ADS/NT 
Support screen appears. You can to change 
any of these items and press Apply to 
confirm your settings. A description of each 
item follows: 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

40 



ADS/NT Support 
Item Description 
WINS Server Specifies the WINS server if necessary. 
Work Group / Domain 
Name 

Specifies the SMB/CIFS Work Group / ADS Domain Name (e.g. 
M3800). 

ADS/NT Support Select Disable to disable authentication through Windows Active 
Directory Server or Windows NT. 

Authentication Method Select ADS for Windows Active Directory Server, or select NT for 
Windows NT 

ADS/NT Server Name Specifies the ADS/NT server name (e.g. adservername). 
ADS/NT Realm Specifies the ADS/NT realm (e.g. example.com). 
Administrator ID Enter the administrators ID of Windows Active Directory or 

Windows NT, which is required for M3800 to join domain. 
Administrator 
Password 

Enter the ADS/NT Administrator password. 

Confirm Password For re-entering password to confirm. 
 
To join an AD domain, you can use the example below to configure the M3800: 
 
AD Domain Example 
Item Information 
Work Group / Domain 
Name 

Thecus 

ADS Support Enable 
ADS Server Name ADServer 
ADS/NT Realm thecus.com 
Administrator ID Administrator 
Administrator 
Password 

*********** 

Confirm Password *********** 

 

• The system time difference between M3800 and ADS should be less than five 
minutes. 

• The Administrator Password field is for the password of ADS (Active Directory 
Server), not the M3800. 

• The time zone setting between M3800 and ADS should be identical.  

• The DNS server specified in the WAN configuration page should be able to 
correctly resolve the ADS server name. NOTE  
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System Settings 
The System menu gives you a wealth of settings that you can use to configure 
your M3800’s system administration functions. You can set up system 
notifications, view system logs, and even upgrade firmware from this menu. 

System Notifications 
From the System menu, choose the 
Notification item, and the Notification 
Configuration screen appears. This screen 
lets you have the M3800 notify you in case 
of any system malfunction. Press Apply to 
confirm all settings. See following table for a 
detailed description of each item. 
 
 
 
 
 
 
 
 
 
Notification Configuration 
Item Description 
Beep Notification Enable or disable the system beeper that beeps when a problem 

occurs. 
Email Notification Enable or disable email notifications of system problems. 
SMTP Server Specifies the hostname/IP address of the SMTP server. 
Port Specifies the port to send outgoing notification emails. 
Auth Type Select the SMTP Server account authentication type. 
SMTP Account ID Set the SMTP Server Email account ID. 
Account Password Enter a new password. 
Confirm Account 
Password 

Confirm a new password. 

Receiver’s E-mail 
Address 

Add one or more recipient’s email addresses to receive email 
notifications. 

Test E-Mail Click to send out a test e-mail to make sure the settings are 
correct. 

 

System Logs 
From the System menu, choose the Logs item 
and the System Logs screen appears. This 
screen shows a history of system usage and 
important events such as disk status, network 
information, and system booting. See the 
following table for a detailed description of each 
item: 
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Consult with your mail server 
administrator for email server 
information. 

NOTE 



System Logs 
Item Description 
Truncate All Log File Clear all log files. 
|<<  <  >  >>| Use the forward ( >  >>| ) and backward ( |<<  < )  buttons 

to browse the log pages. 
INFO Provides all log information including warning messages and 

error messages. 
WARN Shows all warning messages and error messages. 
ERROR Shows only error messages. 
GO Specify the number of lines per page and press Go. 
Ascending Shows logs by date in ascending order. 
Descending Shows logs by date in descending order. 
Download All Log File Export all logs to an external file. 

 

Time and Date Settings 
From the System menu, choose the Time 
item and the Time screen appears. Set the 
desired Date, Time, and Time Zone. You 
can also elect to synchronize the system 
time on the M3800 with an NTP (Network 
Time Protocol) Server. You can change 
any of these items and press Apply to 
confirm your settings. 
  
See the following table for a detailed 
description of each item: 
 
 
 
 
Time 
Item Description 
Date Sets the system date. 
Time Sets the system time. 
Time Zone Sets the system time zone. 
NTP Server Select Yes to allow the M3800 to synchronize with the NTP 

server shown below. 
Select Manually to allow the M3800 to synchronize with an NTP 
server of your choice. 
Select No to not have the M3800 to synchronize with an NTP 
server. 

 
If an NTP server is selected, please make sure your M3800’s network has been 
setup to access the NTP server. WARNING  
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System Configuration Backup and Restore 
From the System menu, choose the Config 
Mgmt item and the System Configuration 
Download/Upload screen appears. From 
here, you can download or upload stored 
system configurations. See the following 
table for a detailed description of each item. 
 
 
 
 
 
 

NOTE 
Backing up your system configuration 
is a great way to ensure that you can 
revert to a working configuration when 
you are experimenting with new 
system settings. 

 
 
 
System Configuration Download/Upload 
Item Description 
Download Save and export the current system configuration. 
Browse Click to browse for the configuration file you wish to import. 
Upload Import a saved configuration file to overwrite current system 

configuration. 
 

Module Management 
From the System menu, choose the 
Module Mgmt item and the Module 
Management screen appears. From here, 
you can install separate software modules to 
extend the functionality of your M3800.  
 
 
 
 

Modules can potentially harm your 
system. Only install modules from your 
vendor, or publishers you can trust. 

NOTE 

 
 
 
 
 
 
Module Management 
Item Description 
Name Displays the name of the module. 
Version Displays the module version. 
Description The description of the module. 
Enable Displays whether the module has been enabled or not. 
Status Displays the status of the module. 
Uninstall Click to uninstall the module. 
Enable (button) Click to enable a module. 
Disable Click to disable a module. 
Browse Click to browse the folder of your PC to locate the module files. 
Install Click to install the listed module into your M3800 
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Reset to Factory Default Settings 
From the System menu, choose the 
Factory Default item and the Reset to 
Factory Default screen appears. Press 
Apply to reset the M3800 to factory default 
settings. Press Cancel to go back to the 
main menu. 
 
 
 
 
 
 
 
 
 
 

WARNING 
Resetting to factory defaults will not erase the data stored in the hard disks, but 
WILL revert all the settings to the factory default values.  

 
 
 

Upgrading System Firmware 
From the System menu, choose the 
Firmware Upgrade item and the 
Firmware Upgrade screen appears.  
 
Follow the steps below to upgrade your 
firmware: 
 

1. Use the Browse button to find the 
firmware file. 

 
2. Press Apply. 

 
3. The beeper beeps and the Busy LED 

blinks until the upgrade is complete. 
 
 
 • The beeper only beeps if it is enabled in the System Notification menu. 

NOTE  • Check Thecus website for the latest firmware release and release notes. 
• Downgrading firmware is not permitted. 

 
 

WARNING 
Do NOT turn off the system during the firmware upgrade
catastrophic result that may render the system inoperable. 

 process. This will lead to a 
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Change Administrator Password 
From the System menu, choose the 
Administrator Password item and the 
Change Administrator Password screen 
appears. Enter a new password in the New 
Password box and confirm your new 
password in the Confirm Password box. 
Press Apply to confirm password changes. 
See the following table for a detailed 
description of each item. 
 
 
 
 
 
 
Change Administrator Password 
Item Description 
New Password Type in a new administrator password. 
Confirm Password Type the new password again to confirm. 
Apply Press this to save your changes. 

 

Reboot and Shutdown System 
From the System menu, choose Reboot & 
Shutdown item, and the 
Shutdown/Reboot System screen 
appears. Press Reboot to restart the 
system or Shutdown to turn the system off. 
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Scheduled Power On/Off 
 
You may also designate a schedule for the 
M3800 to turn on and off. To do this, first 
enable the feature by checking the Enable 
Timer checkbox. Then, simply choose an on 
and off time for each day of the week that 
you would like to designate a schedule by 
using the various dropdowns. Finally, click 
Apply to save your changes. 
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Example - Monday: On: 8:00; Off: 16:00 
System will turn on at 8:00 AM on Monday, 
and off at 16:00 on Monday. System will 
turn on for the rest of the week. 
 
If you choose an on time, but do not assign 
an off time, the system will turn on and remain on until a scheduled off time is 
reached, or if the unit is shutdown manually. 
 
Example - Monday: On: 8:00 
System will turn on at 8:00 AM on Monday, and will not shut down unless 
powered down manually. 
 
You may also choose two on times or two off times on a particular day, and the 
system will act accordingly. 
 
Example - Monday: Off: 8:00; Off: 16:00 
System will turn off at 8:00 AM on Monday. System will turn off at 16:00 PM on 
Monday, if it was on. If the system was already off at 16:00 PM on Monday, 
system will stay off. 
 

TV Setup 
One of very unique feature of M3800 is HDMI/AV out direct connection to TV. 
They are varies options can be setup, please refer the document “M3800 OSD 
User’s Manual” for more details.  
 

 

Logout 
To logout of the Web Administration Interface, navigate to System > Logout. 



Chapter 5: Additional Feature Setup 

FTP Server 
M3800 can act as a FTP server, enabling 
users to download and upload files with their 
favorite FTP programs. From the Network 
menu, choose the FTP item, and the FTP 
screen appears. You can change any of 
these items and press Apply to confirm 
your settings. A description of each item 
follows:  
 
 
 
 
 
 
 
 
 
FTP 
Item Description 
FTP Enable FTP Service on the M3800. 
Port Specifies the port number of an incoming connection on a non-

standard port. 
FTP ENCODE If your FTP client or operating system does not support Unicode 

(e.g. Windows® 95/98/ME or MAC OS9/8), select the same 
encoding as your OS here in order to properly view the files and 
directories on the server. Available options are BIG5, HZ, 
GB2312, GB18030, ISO, EUC-JP, SHIFT-JIS and UTF-8. 

Allow Anonymous FTP 
Access 

Upload/Download: Allow anonymous FTP users to upload or 
download files to/from public folders. 
Download: Allow anonymous FTP users to download files from 
public folders. 
No access: Block anonymous FTP user access. 

Auto Rename If checked, the system will automatically rename files that are 
uploaded with a duplicate file name. The renaming scheme is 
[filename].#, where # represents an integer.  

Upload Bandwidth You may set the maximum bandwidth allocated to file uploads. 
Selections include Unlimited, 1, 2, 4, 8, and 16 MB/s. 

Download Bandwidth You may set the maximum bandwidth allocated to file 
downloads. Selections include Unlimited, 1, 2, 4, 8, 16 MB/s. 

 
 Anonymous users are not able to delete files on the M3800. To delete files, users 

must login and be granted write access on the Access Control List. NOTE  
 
 
To access the share folder on the M3800, use the appropriate user login and 
password set up on the Users page (Accounts > Users). Access control to each 
share folder is set up on the ACL page (Storage > Folder > ACL). 
 
When trying to access M3800 anonymously, just enter “anonymous” as the user 
name. 
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iTunes® Server 
With the built-in iTunes server capability, 
the M3800 enables digital music to be 
shared and played anywhere on the network!  
 
From the Network menu, choose the 
iTunes item, and the iTunes 
Configuration screen appears. You may 
enable or disable the iTunes Service from 
here. Once enabled, enter correct 
information for each field and press Apply 
to save your changes. See the following 
table for detailed descriptions of each field:  
 
 
 
iTunes Configuration 
Item Description 
iTunes Enable or disable the iTunes Service. 
Server Name Name used to identify the M3800 to iTunes clients. 
Password Enter password to control access to your iTunes music. 
Rescan Interval Rescan interval in seconds. 
MP3 Tag Encode Specify tag encoding for MP3 files stored in M3800. All ID3 tags 

will be sent out in UTF-8 format. 
 
Once the iTunes service is enabled, the M3800 will make all music located in the 
Music folder available for iTunes-equipped computers on the network. 
 

Media Server 
With the built-in Media Server capability, the 
M3800 provides media streaming service to 
stand-alone networked home media adapters 
that support the UPnP AV protocol or are 
Digital Living Network Alliance (DLNA) 
standard compliant.  
 
With the M3800’s built-in media server 
capability, you can share digital media such 
as music, pictures, and movies with any 
compatible device throughout your entire 
home. 
 
To configure the media server, under the 
Network menu, click Media Server and 
the Media Manager Settings window will 
appear. A description of each field follows: 
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Media Manager Settings 
Item Description 
Media Server Enable or disable the Media Server service. 
Shared Media Folders Select the folder(s) that contains media files to be shared. 
Rescan Click the Rescan button to have the M3800 for new contents in 

the selected media folder. 

Adding Media Share Folders 
Once the Media Server software is installed, you can start adding folders that 
contain the media that you would like to share. To create a media share folder, 
follow the steps below: 
 

1. Click on Network > Media Server in the menu bar.  
 

2. From the Shared Media Folders window, select the folder that contains 
your media files, and click its checkbox. 

 
3. The contents in the folder will be scanned for the Media Server. The time 

required for scanning depends on the size of the folder. 
 

Connecting DMAs to the Media Server 
Next, it’s time to connect your Digital Media Adapter (DMA) to the media server: 
 

1. Connect your DMA to your Media Server 
 

a. Configure your DMA to use a Dynamic IP address. The IP address 
will be assigned by the router. 

b. Some DMAs are wireless enabled. You can connect the DMA to a 
wireless router. For instructions on how to connect your DMA to a 
wireless router, please refer to your DMA’s user manual. 

 
2. Connect your DMA’s video output to video input of your TV set. 
 
3. Turn on the TV and change the video signal input to DMA. 

 
4. Setup the DMA (These steps will be different if you use a different DMA) 

 
a. From the Server List screen, select “M3800:Mediabolic Server” 

as the server. 
b. Go to My Media 
c. Click on the Up/Down Arrow buttons to select Music Jukebox, 

Photo Albums, or Video Clips 
d. Start enjoying the contents stored in your M3800. 

 



Download Manager 
With the built-in Download Manager, you 
can have the M3800 download HTTP, FTP, 
and BT files without having full PC powered 
on. What’s more, you can even schedule 
your downloads for off-peak hours, ensu
efficient use of bandwidth. To access the 
Download Manager, go to Network, choose 
the Download Manager option, and the 
Download Tasks and Download 
Schedule windows

ring 

 appear.  
 
 
 
 
 
Download Tasks 
Item Description 

 Click to start the specified task. 

 Click to pause the specified task. 

 
Click to delete the specified task. A prompt will appear asking you 
if you would like to delete the task itself, or the task and all 
related downloaded files. 

Task Name of the task. Click to see more information about this task. 

Type Type of transfer. Can be HTTP, FTP, or BT. 

Rate 
Transfer rate of the task in kilobytes per second (KB/s). 
DL: Download rate 
UL: Upload rate 

Status 
Status of the task. 
Complete: Percentage complete (%) 
Completed / Total download size 

Task Type 
Use this dropdown to select the type of transfer. HTTP, FTP, and 
BT are available. 

Add Task Click to add the kind of task specified beside “Task Type”. 

Enable Refresh Click to refresh the task list. 
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Adding an HTTP Task 
To add a new HTTP task to the Download Manager, follow these steps: 
 

1. Using the Task Type dropdown, select HTTP and click Add Task.  
 

 
 
2. In the HTTP Task window, start by inputting the target URL in the 

Website URL box. This is the link to the download you want to queue. 
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3. Next, select the destination folder from the Destination Folder dropdown. 

This is where the download will reside. 
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4. Select the maximum download bandwidth from the Max. Download 

Bandwidth dropdown. 
 

 
 

5. Press Apply to add the task. 



 
6. Once added, your download will appear in the list of download tasks. To 

start the download, simply click the Start icon ( ) and the download will 
begin. 
 

 
 
7. The download status will continually update in the Download Tasks 

window. To pause the download, click the Pause icon ( ).  
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Adding an FTP Task 
To add a new FTP task to the Download Manager, follow these steps: 
 

1. Using the Task Type dropdown, select FTP and click Add Task.  
 

 
 
2. In the FTP Task window, start by inputting the target URL in the FTP File 

box. This is the link to the download you want to queue. 
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3. Next, select the destination folder from the Destination Folder dropdown. 

This is where the download will reside. 
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4. The next step depends if you are using an anonymous login for your FTP 

download. If you are logging in anonymously, select Anonymous Login 
and move on to step 5. 

 

 
 



If you are required to login with a user name and password, select 
Username and input your user name and password into the appropriate 
fields.  
 

 
 

5. Select the maximum download bandwidth from the Max. Download 
Bandwidth dropdown. 
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6. Press Apply to add the task. 



 
7. Once added, your download will appear in the list of download tasks. To 

start the download, simply click the Start icon ( ) and the download will 
begin. 
 

 
 
8. The download status will continually update in the Download Tasks 

window. To pause the download, click the Pause icon ( ).  
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Adding a BT Task 
To add a new BT task to the Download Manager, follow these steps: 
 

1. Using the Task Type dropdown, select BT and click Add Task.  
 

 
 
2. In the BT Task window, start by clicking Browse… and selecting the 

torrent file you wish to start. 
 

 

 
 
 

59 



 
3. Next, select the destination folder from the Destination Folder dropdown. 

This is where the download will reside. 
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4. Next, you can select the maximum and minimum number of peers from 

selecting the counts from the appropriate dropdowns. 
 

 
 



 
5. Next, you can set the maximum download and upload bandwidths from 

the dropdowns below. 
 

 
 

6. Press Apply to add the task. 
 
7. Once added, your download will appear in the list of download tasks. To 

start the download, simply click the Start icon ( ) and the download will 
begin. 
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8. The download status will continually update in the Download Tasks window. 

To pause the download, click the Pause icon ( ).  
 

 

Deleting Tasks 
To delete a task, simply follow the steps below: 
 

1. Click the delete icon ( ) beside the task that you wish to delete. The 
Delete Task dialogue box will appear. 

 
2. Select Delete Task only if you wish to remove only the torrent file and all 

transient files, leaving the unfinished download files intact. 
 

3. Select Delete Task and Files if you wish to remove the torrent file and 
all transient files, and the unfinished download files. 

4. Click OK to delete the task. Click Cancel to return to the Download 
Manager. 

Scheduling Downloads 
With the Download Manager, you can schedule your downloads to begin at 
different times of the day. This is useful if you wish to complete your downloads 
during off-peak hours, reserving your bandwidth for other applications. A table 
describing the Download Schedule window appears below: 
 
Download Schedule 
Item Description 
Scheduler Enable or disable the Download Scheduler. 

Daily/Weekly 
Choose to have the Download Scheduler activate on a daily or 
weekly basis. 

Start: Day/Hour 
/Minute 

Specify the start day/hour/minute for the download task. 

End: 
Day/Hour/Minute 

Specify the end day/hour/minute for the download task. 
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To schedule downloads, follow these steps: 
 

1. Under Download Schedule, set Scheduler to Enable. 
 

 
 
2. To schedule a daily download period, select Daily and select a start time 

and end time.  
To schedule a weekly download period, select Weekly and select a start 
day/time and end time/day.  

 

 
 

3. Click Apply to save your changes. 
 

If the Download Scheduler is enabled, ALL download tasks will adhere to the 
designated schedule. NOTE  
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Web Cam Server 
With the Web Cam Server, you can schedule the N3200PRO to capture images 
with a connected USB webcam. To configure the Web Cam Server, go to Status, 
choose the Web Camera option, and the Web Camera window appears.  
 
 
 
Web Camera 
Item Description 

Image Size 
Select an image size for each captured image. Can be 160x120, 
320x240, or 640x480. 

Interval Select an interval between each captured image.  

Schedule Click to schedule webcam image capture. 

Preview Click to preview the image capture. 

Apply Click to save your changes. 

Web Cam Preview 
 
From the Web Camera window, you can click the Preview button to view the 
image from the Web Cam before setting up the recording schedule if you wish. 
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Note: 
Picture quality may vary due to the number of different USB Web Cams 
on market with varying hardware components. 

 
Once you are happy with the Web Cam preview, your can select the resolution 
you want. There are 3 different choices: 
 

 160x120 
 320x240 
 640x480 

Use the drop down to select the desired recording interval.  
 
Click Apply to save your changes.  
 

 
 

Adding a Web Cam Schedule 
 
After finishing with the basic settings, we need to now configure the capture 
schedule. To do this, begin by activating the schedule function by selecting 
Enable in the Web Camera Schedule window.  
 

 
 
Next, select time slot you want to record through the Web Cam.  
 
If Always is selected, it will start to record right away and will not stop until the 
Web Camera Schedule is set to Disabled.  
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Alternatively, you can schedule the Web Cam to capture daily or hourly. Take a 
look at the example below. It will record every Monday and Tuesday from 2:00 – 
6:00 and from 20:00 – 22:00.  
 

 
 
One important point worth mentioning is how captured picture is stored. The 
folder where captured images are stored is the Video system folder, which is 
associated with the system-created Web Cam sub folder. See the figure below 
for reference: 
 

 
 
 

66 



 

 
 
The Web Cam will capture images according to the designated schedule. The files 
will be stored using following path: 
 
Video + Webcam + date + hour (path)  filename.jpg 

Printer Server 
You can configure the M3800 to act as a 
printer server. That way, all PCs connected 
to the network can utilize the same printer.  
 

Windows XP SP2 
To set up the Printer Server in Windows XP 
SP2, follow the steps below: 
 

1. Connect the USB printer to one of 
the USB ports (preferably the rear 
USB ports; front USB ports can be 
used for external HDD enclosures). 

 
2. Go to Start > Printers and Faxes. 

 
3. Click on File > Add Printer. 
 
4. The Add Printer Wizard appears on your screen. Click Next. 

 
5. Select the “A network printer, or a printer attached to another 

computer” option. 
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6. Select “Connect to a printer on the Internet or on a home or office 
network”, and enter “http://M3800_IP_ADDRESS:631/printers/usb-
printer” into the URL field. 

 
7. Your Windows system will ask you to install drivers for your printer. Select 

correct driver for your printer. 
 

8. Your Windows system will ask you if you want to set this printer as 
“Default Printer”. Select Yes and all your print jobs will be submitted to 
this printer by default. Click Next. 

 
9. Click Finish. 

 
 • Not all USB printers are supported. Please check Thecus website for a list of 

supported printers. NOTE  • Note that if a multi-function (all-in-one) printer is attached to the M3800, 
usually only the printing and fax functions will work. Other features, such as 
scanning, probably will not 

 
function. 
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Windows Vista 
To set up the Printer Server in Windows Vista, follow the steps below: 
 

1. Open Printer Folder from the Control Panel. 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Click the right mouse button in anywhere on the Printers folder and then 
select Add Printer. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select Add a network, wireless or Bluetooth printer. 
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4. Select The printer that I want isn’t listed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can press The printer that I want isn’t listed to go into next page 
without waiting for Searching for available printers to finish. 

 
5. Click Select a shared printer by name. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Type http://<Thecus_NAS>:631/printers/usb-printer in the box, 
where <Thecus_NAS_IP> is the IP address of the M3800. Click Next. 

 
6. Select or install a printer and then press OK. 
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If your printer model is not listed, please contact your printer 
manufacturer for help. 
 

 



7. Windows will attempt to connect to the printer. 
 
 
 
 
 
 
 
 
 

 
 
8. You can choose to set this printer as the default printer by checking the 

Set as the default printer box. Click Next to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
9. Done! Click Finish. 
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Chapter 6: Using the M3800 

Overview 
Once the M3800 is setup and operating, users on the network may manage all 
varieties of digital music, photos, or files by simply using their web browsers. To 
manage your personal files or access public files on the M3800, just enter its IP 
address into your browser (default IP address is http://192.168.1.100), and 
you will be taken to the M3800 Login page. 
 

NOTE 
Before proceeding, make sure that WebDisk Support or Secure WebDisk Support is 
enabled in the Service Support screen in the system’s Network menu. See Service 
Support in Chapter 4: System Management > Network Management > Web 
Services Configuration. 

 
 
 

Login Page 
To login to the system, enter your user 
name and password, and click Login to log 
into the system. You will be taken to the 
Web User Interface. 
 
 
 
 
 
 
 
 
 
 
 

Web User Interface 
The Web User Interface is where users interact with the M3800, and manage all 
sorts of digital media. The simple layout makes it easy for anyone to enjoy the 
many features of the M3800.  
 
On the left of the interface is the Main 
Menu, where you can easy access the 
WebDisk, Music, and Gallery functions 
of the M3800. Along the top of the 
interface, you to choose to browse all 
storage devices connected to the M3800, 
including SATA and eSATA hard disks, 
USB disks, and contents stored from the 
USB One-Button Copy function. 
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Web User Interface 
Item Description 
WebDisk 
 
 

Click to use the WebDisk function. 

Music 
 
 

Click to use the Music function. 

Photos 
 
 

Click to use the Photo Gallery function 

Login 
 
 

Click to login to the M3800. 

Logout 
 
 

Click to return to the M3800 Login page. 

Change 
Password 
 

Click to change your login password. 

 
 
 

73 

 

Using WebDisk 
1. When any user clicks on the WebDisk icon, they will see all available 

public folders. 
2. When they click on the name of a public folder, they will see the files 

within that folder.  
3. When user clicks on a file name, the file will be downloaded. 

 
WebDisk 
Icon Function Description 

 
File Search Search for specific files or folders. 

 Sort Arrange all files and folders by type, 
name, size, or last modified date. 

 
Delete 
 

Delete the selected files or folders. 

 
Page Number Use this to navigate when multiple 

pages are required to list the 
contents of the selected directories. 

 
Create New 
Folder 
 

Enter a new folder name and press 
the Create button. 

 
Upload Files 
 

Browse to the desired file location 
and press the Upload button. 

NOTE 
The Delete, Create New Folder, and Upload Files options are only visible if the user 
has write access to the specific folder. 

 
 
 
 
 
For more information on how to setup user rights to the folders, please check 
Chapter 3: System Management > Storage Management > Folder 
Management > Folder Access Control List (ACL)  
 
To access folders with access control, you must first login with a local user 
account. To log in, please click on the Login icon on the lower left hand corner. 



Using Music Server 
To manage your digital music and share it with iTunes clients on the network, 
click on the Music icon from the left panel. 
 
Music 
Icon Function Description 

 
File Search Search for specific files or folders. 

 Sort Arrange all files and folders by type, 
name, size, or last modified date. 

 
Delete*  
 

Delete the selected files or folders. 

 
Page Number Use this to navigate when multiple 

pages are required to list the 
contents of the selected directories. 

 
Create New 
Folder* 
 

Enter a new folder name and press 
the Create button. 

 
Upload Files*  
 

Browse to the desired file location 
and press the Upload button. 

 
The Delete, Create New Folder, and Upload Files options are only visible if the user 
has write access to the specific folder. 

 
NOTE  

 
 

Adding Music Files 
You could add music files into iTunes Server through Web User Interface; 
however, if you have lots of folders and files to upload, there is a simpler way. 
 

1. Open a Windows Explorer and type the M3800 IP address in the address 
bar (i.e. \\192.168.1.100). 

 
2. Double click the Music folder to enter it. Then drag and drop music folders 

and files here. 
 

3. The M3800 iTunes server will take some time to cache the ID3 tag of 
every file. Once the process is done, you will see all the music files from 
iTunes clients. 

 

Playing Music Files 
Once your music files are added to the M3800, playing them on any iTunes-
equipped computer connected to the network is easy: 
 

1. Open iTunes. 
 
2. You should see Thecus_M3800 under the SHARED heading in the left 

hand menu. 
 

3. Click Thecus_M3800 and all shared music will be displayed, ready to be 
enjoyed right from iTunes. 

 
4.  
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Using Photo Gallery 
Using the Photo Gallery, users can 
view and share photos, and even 
create their own albums right on the 
M3800. To manage your photo 
gallery or see other photo albums, 
click on the Photos icon from the 
left panel. 
 
You will see your own Photo Gallery 
and all public Photo Albums on the 
network. 
 
To manage any picture files, you must first select the item by clicking its check 
box. 

Managing Albums and Photos 
 
Photo 
Icon Function Description 

 
Make Cover Make selected photo your cover picture. 

 
Back Return to the previous screen. 

 
Add Add a new album or photos. 

 
Modify 
 

Edit the name and description of the selected album or 
photo. Each name is limited to 20 characters and each 
description is limited to 255 characters. 

 
Delete Delete the selected albums or photos. 

 

NOTE • Only logged in users will see these icons. 

• If duplicate file names exist during upload process, system will add a 
number in front of the original file name (abc 1abc). 

• Each file upload is limited to a size of 4MB. Files exceeding 4MB will NOT 
be uploaded and no error message will appear. 

• Only these photo file types will be uploaded: *.jpg, *.gif, *.bmp, *.png, 
*.pcx, *.psd, *.bmp. 

• To prevent system errors, the M3800 sets the following limitations on photo 
files: 

 
 
 
 
 
 

Creating Albums 
To create a photo album, follow the steps below: 
 

1. Click the Add button to create a new album. 
 

2. Enter a name for the album, and enter a description if you wish. Then, 
click on the Create Album button. 

Password Protecting Albums 
If you would like to put a password on a particular album, follow these steps: 
 

1. Select the album to be protected, click on the Edit button, and the Album 
Edit screen will appear.  
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2. The owner of the album can enter an album password to protect the 
album, so that only people with the correct password can view the album.  

Uploading Pictures to Albums 
Uploading pictures to albums using the Web User Interface is easy: 
 

1. When the album is created, click the album icon to enter the album. 
Initially the album is empty.  

 
2. Click the Add button to upload pictures into the album. The Upload 

Photos screen will appear. Users can select and upload up to 8 pictures at 
a time. 

 
3. Once the picture is uploaded, you can view it in the album.  

 
4. The owner of the album can delete or modify the pictures with the Delete 

or Modify buttons on the top right hand corner.  

Windows XP Publishing Wizard 
There are many ways for a local user to upload pictures into their photo album. 
Users of Windows XP can upload their pictures using the Windows XP Publishing 
Wizard. 
 

1. Click on the XP Publishing Wizard icon. 
 

 
 
2. The XP Web Publishing Wizard Client screen appears. Click on the link 

to install the Publishing Wizard.  
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3. Windows XP will ask whether you want to run or save this file. Click Run. 
  

 
 

4. Once the Wizard is installed, use the Windows file manager to browse the 
folder that contains the picture you want to publish. On the left pane, 
there will be an icon labeled “Publish this folder to the Web”.  

 

 
 

5. Click on this icon and Web Publishing Wizard will start.  
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6. Select the pictures you want to publish to the Photo Web Server by placing 
a check mark on the top left hand corner of the picture. Click Next.  

 
 

7. Your PC will start to connect to the Photo Web Server. 
 

8. Select M3800 Photo Gallery Wizard to publish your pictures to the 
M3800.  

 
 

9. Login into the M3800 with your local user name and password. 
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10. Create your album by entering an album name and clicking on the Create 
Album button.  

 

 
 

11. Select the album you want to upload your pictures to. 
 

12. Confirm the target album.  

 
 

13. Windows will show you that the picture upload is in progress. 
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14. When the upload is finished, the Wizard will ask you whether if you want 
to go to the website. Click Finish to go to your Photo Web Server. 

  
15. Click on the user’s icon to go to that user’s album.  

 
16. You will see the user’s album list. Click on user.  

 
17. Finished! You will see the pictures just selected in the album.  
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EXIF Information 
While viewing pictures, you can also have the M3800 display the EXIF information 
for each photo. 
 

 
 
Simply click the EXIF button to display EXIF information. To hide this information, 
click the EXIF button again. 

Slide Shows 
Slide shows are a great way to enjoy pictures stored on your M3800.  
 
You can click on the Start Slide Show icon on the top right hand corner to start 
the slide show. 
 

 
 
To stop the slide show, click on the Stop Slide Show icon on the top right hand 
corner.  
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Mapping a Client PC to the M3800 
You can map share folders on the M3800 so that you can access them as if they 
were drives on your computer. You can connect to the shared network folders on 
the M3800 as follows:  

Windows 
1. Go to the My Computer folder in Windows. 
 
2. In the menu bar, select Tools and then Map Network Drive… 

 
3. The Map Network Drive window appears. 

 
4. Assign a drive letter for the share folder.   

 
5. Click the Browse button to find the folder over your network. Alternatively, 

you may enter the folder name you wish to connect to or enter its IP 
address. (i.e. \\192.168.1.100\share) 

 
6. Click Finish. When the Connect As… window appears, enter your user 

name and password. 
 
 

7. Click OK. The share folder appears as the drive you assigned. You can now 
access this folder as though it were a drive on your computer.  

Apple OS X 
On an Apple computer, you can connect to shared computers and servers using a 
network address.  
 

1. Choose Go > Connect to Server… 
 
2. Enter the network address for the server in the Server Address text box. 

 
When connecting using SMB/CIFS protocol, type: 
smb://192.168.1.100/Folder1 
 
When connecting using AFP protocol, type: 
afp://192.168.1.100/Folder1 
 
Click Connect. 
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3. When MAC OS X is trying to connect M3800, it will ask for a User Name 
and Password which has access to the folder. 

 
4. When MAC OS X has connected to the M3800 successfully, an icon 

representing the folder will appear on the MAC OS X desktop. You can 
access the folder by double clicking on the icon. 

 
 



File Backup 
There are a number of ways to back up data with the M3800.  

Thecus Backup Utility 
The Thecus Backup Utility is on your Installation CD. When you click on the CD, 
the Backup Utility will be installed under Program Groups > Thecus > Thecus 
Backup Utility. If it is not installed, you can copy the file (Thecus Backup 
Utility.exe) to a convenient location on your hard disk and double click to 
execute it. 
 

 
 

If you can not find Thecus Backup Utility on your CD, please download it from the 
Thecus website (http://www.thecus.com). NOTE  

 
 
When you execute this utility for the first time, it will ask you whether to create a 
DB file. Click Yes. 
 

1. Click Add to create a Backup task. The Add New Task dialog box appears. 
 
Add New Task 
Item Description 
Task Specifies a name for the current task. 
Source Click to specify the source folder/file location. 
Incremental Click to specify whether the backup will be incremental. 

If unchecked, the backup will be a full backup. 
Destination Click to specify the destination folder/file location. 
Excluded extensions Files with these file name extensions will be skipped and not 

back up to the destination. 
Comments If you wish, enter comments here for your records. 

 
2. To schedule the task to run at regular intervals, click on the Schedule 

icon for that task. You can schedule the task to run Monthly or Weekly. 
 

3. To check the log for that task, click on the Log icon for that task. 

Thecus Backup Utility also supports MAC OS X. Just copy the Thecus Backup 
Utility.dmg to your MAC OS X machine and double click to execute it. NOTE 
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Windows XP Data Backup 
If you use Windows XP Professional, you can also use the Windows Backup Utility 
(Ntbackup.exe) to backup your files. 
 
If you use Windows XP Home Edition, follow these steps to install the utility: 
 

1. Insert the Windows XP CD into a drive and double-click the CD icon in My 
Computer. 

 
2. When the Welcome to Microsoft Windows XP screen appears, click 

Perform Additional Tasks.  
 

3. Click Browse this CD.  
 

4. In Windows Explorer, navigate to ValueAdd > Msft > Ntbackup.  
 

5. Double-click Ntbackup.msi to install the backup utility. 
 
Once installed, you can use the Windows Backup Utility by following the steps 
below: 
 

1. Click Start, and point to All Programs > Accessories > System Tools 
> Backup to start the wizard. 

 
2. Click Next to skip past the opening page. Choose Backup files and 

settings from the second page, and then click Next.  
 

3. Select which option you want to back up. 
 

4. Click Next and in the Backup Type, Destination, and Name page, specify a 
back up location using the Browse button. 

 
5. Find and select the drive that specifies your M3800 as your backup 

destination and click Next. 
 

6. Click Next to display the wizard’s final page and click Finish to start 
backing up.  

Apple OS X Backup Utilities 
Mac OS X does not include any backup software. However, there are a number of 
backup solutions available for the Mac OS X, including: iBackup, Psyncx, iMSafe, 
Rsyncx, Folder Synchronizer X, Tri-BACKUP, Impression, Intego Personal Backup, 
SilverKeeper, and Apple's dotMac Backup utility to name just a few. To find even 
more freeware and shareware backup utilities to choose from, go to 
VersionTracker or MacUpdate and search on "backup". 
 

http://www.grapefruit.ch/grapefruit/iBackup/
http://sourceforge.net/projects/psyncx
http://homepage.mac.com/sweetcocoa/imsafe/
http://www.macosxlabs.org/rsyncx/rsyncx.html
http://www.softobe.com/products/flsy/pp.html
http://www.tri-edre.com/english/tribackup.html
http://babelcompany.com/impression/
http://www.intego.com/personalbackup/home.html
http://www.lacie.com/silverkeeper/
http://www.versiontracker.com/
http://www.macupdate.com/


Chapter 7: Tips and Tricks 

USB and eSATA Storage Expansion 
The M3800 supports external USB hard disks through its three USB ports. Once a 
USB hard disk has successfully mounted, the entire volume will be copied 
automatically to the default USB HDD folder. The M3800 supports up to 6 USB 
external storage devices. All file names on the USB disk volume are case sensitive. 
 
The M3800 also supports eSATA hard disks with its eSATA port. 
 
Before attaching an eSATA or USB disk drive to M3800, you have to partition and 
format it on a desktop computer or a notebook first. The attached device will be 
located at \\192.168.1.100\usbhdd\sdf1 where 192.168.1.100 means the IP 
address of M3800 and sdf1 stands for the first partition on disk #6, the eSATA or 
USB disk drive. If it is an NTFS partition, NAS users can open or copy files from 
\\192.168.1.100\usbhdd\sdf1 but cannot add new files or modify existing files.  
 
 

NOTE 
If you want to write to an USB storage device, the file system must be FAT32. 

  
USB Storage FAT32 Partition NTFS Partition  Read OK OK 

 Write OK - 
 

 

Adding a Spare Disk  
With a RAID 1 array, you can add a spare disk after the initial RAID is setup. To 
add a spare disk, follow the steps below: 
 

1. On the RAID Configuration Screen, tick the checkbox of the hard disk 
you wish to designate as a spare disk. 

 
2. Click Add Spare.  

 
Once the disk is set as a spare disk, it will automatically rebuild the previous 
RAID set when one of the disks becomes degraded. 
 

Remote Administration 
You can set up your M3800 for remote administration. With remote 
administration, you can access your M3800 over the Internet, even if your M3800 
is behind a router. This is especially useful if you are traveling and suddenly need 
a file from your M3800.  
 
Setting up remote administration is a three-part process, and will require the 
following equipment: 
 
• Thecus M3800 NAS device 
• Cable/DSL Router with Dynamic DNS support 
• Home PC 
• Internet Connection 
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 Router setup will differ slightly depending on router used. For this example, we will 
use the Asus WL500g because it has support for Dynamic DNS. Contact your router 
hardware vendor for setup help. 

NOTE  
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Part I - Setup a DynDNS Account 
 

1. Go to http://www.dyndns.org from your home PC. 
2. Click on the Sign Up Now link. 
3. Check the Check boxes, select a user name (i.e.: M3800), enter your 

email address (i.e.: xxx@example.com), check Enable Wildcard, and 
create a password (i.e.: xxxx). 

4. Wait for an email from www.dyndns.org. 
5. Open the email and click on the link to activate your account 

Part II - Enable DDNS on the Router 
 

1. Go to the router setup screen and select IP Config > Miscellaneous 
DDNS Setting from your Home PC. 

2. Click on Yes for Enable the DDNS Client? 
3. Select www.dyndns.org. 
4. Go to router setup screen, and enter the following information: 

a. User Name or E-mail Address: xxx@example.com 
b. Password or DDNS Key: xxxx 
c. Host Name: www.M3800.dyndns.org 
d. Enable wildcard? Select Yes 
e. Update Manually: Click Update 

Part III - Setting up Virtual Servers (HTTPS) 
 

1. Navigate to NAT Setting > Virtual Server. 
2. For Enable Virtual Server?, select Yes 
3. Setup the HTTPS Server 

a. Well-Known Applications: Select User Defined 
b. Local IP: Enter 192.168.1.100 
c. Port Range: 443 (the default HTTPS port setting on the M3800) 
d. Protocol: select TCP 
e. Click Add. 
f. Click Apply. 

4. Test the HTTPS connection from another computer on the Internet 
a. From a remote computer, open your browser and enter 

https://www.M3800.dyndns.org 
b. You should see the login page of M3800. 

 

Firewall Software Configuration 
If you are using a software firewall (i.e. Norton Internet Security) and are having 
trouble connecting to the M3800, you can try the following steps: 
 

1. Double click the NIS icon on system tray, and then configure the 
Personal Firewall. 

 
2. On the Programs page, find the SetupWizard.exe and change its 

permission to "Permit All". If it's not in the program list, use the Add or 
Program Scan buttons to find it. 

 
3. On the Networking page, manually add M3800 IP address (i.e. 

192.168.1.100) to the Trusted list.  
 



Replacing Damaged Hard Drives 
If you are using RAID 1 or RAID 5, you can easily replace a damaged hard drive 
in the Thecus M3800 while keeping your data secure with the system’s automatic 
data recovery.  

Hard Drive Damage 
When a hard drive is damaged, LCM will display「RAID Damage」and system 
beeps. 

Replacing a Hard Drive  
To replace a hard disk drive in the M3800: 
 

1. Remove the tray with the damaged hard disk. 
 
2. Insert the hard disk tray then slide into the M3800 until it snaps into place.  

 
3. The LED solid green when the HDD is accessed. 

RAID Auto-Rebuild 
When using RAID 1 or RAID 5 on the M3800, you can use the auto-rebuild 
function when an error is detected.  
 

1. When a hard disk fails the system beeps and/or an email notification is 
sent to specified receivers. 

 
2. Check the log message to see which disk has failed. 

 
3. Follow the steps mentioned above to replace the failed hard disk. 

 
4. The system automatically recognizes the new hard disk and starts the 

auto-rebuild sequence to resume its status before the hard disk crash. 
 

 

File System Check 
The M3800 has a built-in utility that allows you to check the M3800’s file system 
for errors. To use the File System Check utility, follow the steps below: 
 

The File System Check utility works only with WAN and not LAN. 
 

WARNING 
 
 
 

1. Power off the M3800. 
 
2. With the unit powered off, press and hold the reset button.  

 
3. With the reset button held down, power on the system by pressing the 

power button. You can release the reset button after 3 seconds alone with 
2 beeps. After that, the M3800's WAN IP address will be reset to 
192.168.1.100 temporarily. Please note that all file services at this time 
will be stopped. 

 
4. When you point your browser to 192.168.1.100, you will see the following 

screen. 
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5. If you select “Run file system check” option, the file system check utility 
will be started, and last 20 lines of the result will be displayed in your 
browser. 

 

 
 
 

6. When the file system check is finished, the result will be displayed in your 
browser. 
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NOTE 

If the file system is corrupted beyond repair, you may have to remove RAID and 
recreate the file system. 
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Chapter 8: Troubleshooting 

Forgot My Network IP Address 
If you forget your network IP address and have no physical access to the system, 
you can find out the IP address by either looking directly onto the M3800’s LCD 
panel, or by using the setup wizard to retrieve the IP of your M3800. 

1. Start the Setup Wizard, and it will automatically detect all Thecus IP 
storage products on your network. 

 
2. You should be able to find the IP address of the M3800 which you have 

forgotten in the Device Discovery screen. 

Resetting NAS IP Address and Admin Password 
In case you changed the M3800 IP address and then forgot it, or forgot the 
administration password, follow the steps below to reset to default settings:  

1. Power on the M3800 and immediately press the Reset button for 5 
seconds. (The reset button is near the LAN connector) 

 
2. This resets the M3800 to its default IP address and password settings.  

 
Default IP: 192.168.1.100 for WAN and 192.168.2.254 for LAN 
Default admin password: admin 
Jumbo Frame support: disabled  

Can't Map a Network Drive in Windows XP 
You may have problems mapping a network drive under the following conditions: 

1. The network folder is currently mapped using a different user name and 
password. To connect using a different user name and password, first 
disconnect any existing mappings to this network share. 

 
2. The mapped network drive could not be created because the following 

error has occurred: Multiple connections to a server or shared 
resource by the same user, using more than one user name, are 
not allowed. Disconnect all previous connections to the server or shared 
resource and try again. 

 
To check out existing network connections, type net use under the DOS prompt.  

Restoring Factory Defaults 
From the System menu, choose the Factory Default item and the Reset to 
Factory Default screen appears. Press Apply to reset the M3800 to factory 
default settings. 
 
 

WARNING 
Resetting to factory defaults will not erase the data stored
WILL revert all the settings to the factory default values. 

 in the hard disks, but 
 
 

Problems with Time and Date Settings 
The administrator is able to select an NTP Server to keep the M3800’s time 
synchronized. However, if the M3800 can not access the Internet, you may 
encounter a problem when setting the Time and Time Zone. If this happens: 
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1. Login to the Web Administration Interface. 
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2. Navigate to System > Time. 

 
3. Under NTP Server, select No. 
 
4. Set the Date, Time, and Time Zone. 

 
5. Click Apply. 

 
In addition, if the M3800 is able to access the Internet and you want to keep the 
NTP Server clock.isc.org by default, please make sure the DNS Server is correctly 
entered, thereby allowing the NTP Server name to correctly resolve. (See 
Network > WAN > DNS Server) 
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Appendix A: Product Specifications 

Hardware Specifications 
 
Network Interfaces 
WAN Gigabit RJ-45 connector 
LAN  Gigabit RJ-45 connector 
WLAN  IEEE 802.11b/g (using approved USB Dongles)** 
Storage 
HDD Bays 3 x 3.5” SATA HDD, hot-swappable 
HDD Support SATA II HDDs up to 1000GB 
I/O Interfaces 
USB Ports 2 x USB 2.0 ports  
eSATA 1 x eSATA connector for capacity expansion 
PCI Interface For proprietary Thecus applications 
IR Receiver For future options 
System Information 
LCD Module For basic configurations and status display 
System LED Display 1 x Power LED  

2 x Network Link/Activity LED 
3 x Hard Drive Power/Activity LED 

Physical 
Power Supply AC 100 ~ 240V, 50/60Hz, Auto-detection 
Environment 
Temperature 5 ~ 40°C 
Humidity 0 ~ 80% relative humidity (non-condensing) 
Certifications CE, FCC, BSMI, C-Tick, RoHS Compliant 

 
 

Software Specifications 
 
Network 
Network Configuration Fixed IP address 

Dynamic IP address 
PPPoE 
DDNS 

Network File Protocols Microsoft Networks (CIFS/SMB) 
Apple Filing Protocol (AFP 3) 
Network File System (NFS v3) 
File Transfer Protocol (FTP) 
Hyper Text Transfer Protocol (HTTP) 
Secure Hyper Text Transfer Protocol (HTTPs) 

Network Client Type Microsoft Windows NT/2000/XP/2003/Vista 
Unix/Linux/BSD 
MAC OS X/9/8.6 

DHCP Server Assigns IP addresses on LAN/WLAN ports 
Disk Management 
RAID RAID 0, 1, 5, and JBOD 

Auto rebuild 
Hot swappable 

Power Management Disk idle spin-down 
Disk Status Monitoring Disk status monitoring (S.M.A.R.T.) 
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Multimedia Support 
Media Server Works with DLNA-certifies players 

Supported file types:RMP, WPL, PLS, M3U, ASX, WAV, 
PNG, BMP, AVI, WMV, WMA, LPCM, JPEG 

iTunes® Server Supported File Types: WAV 
Photo Web Server Supported File Types: GIF, JPG (JPEG), BMP, PNG 

Supports EXIF display 
Supports slide show 

Web Cam Server Supports image capture, preview, schedule 
Supported image sizes: 160x120, 320x240, 640x480 

Share Management 
Authentication Local User Account 

Microsoft NT Domain Controller (PDC)* 
Microsoft Active Directory Authentication (AD)* 

Folder Management Share folder level permission 
File level permission 
Public folder 

File System 
File System Type Journaling File System 
Language Support Unicode Support 
File Size Supported Supports files up to 2TB max. 
Authorization Read, Write or Deny options on individual users 

or groups 
Administration 
Interface Web-based server management GUI 

Multilingual support (English, French, German, Italian, 
Traditional Chinese, Simplified Chinese, Japanese, 
Korean, and Spanish) 

Setup Wizard Device discovery and setup utility program 
Windows 2000/XP/2003 
MAC OS X 

Notification Sends system messages via e-mail to specified email 
accounts 

Backup 
Thecus Backup Utility Client backup utility 

Windows XP/2000 
MAC OS X 

One-Button Copy Copy USB mass storage device contents to NAS 
Miscellaneous 
Print Server Network printing through IPP using USB printer 
Download Manager Supports BT, FTP, HTTP scheduled downloads 
Scheduled On/Off Scheduled on/off for power saving 

 
*PDC/AD support: Works as a client member in a Microsoft NT 4.0 domain/Active 
Directory domain, allowing the M3800 to utilize the domain users and groups 
setting for authentication to the system and authorization to the share folders. 
 
**For supported USB dongles, please contact sales@thecus.com 

mailto:sales@thecus.com


Appendix B: Customer Support 
 
If your M3800 is not working properly, we encourage you to check out Chapter 8: 
Troubleshooting, located in this manual. You can also try to ensure that you are 
using the latest firmware version for your M3800. Thecus is committed to 
providing free firmware upgrades to our customers. Our newest firmware is 
available on our Download Center: 
 
http://www.thecus.com/download.php 
 
If you are still experiencing problems with your M3800, or require a Return 
Merchandise Authorization (RMA), feel free to contact technical support via our 
Technical Support Website: 
 
http://www.thecus.com/support_tech.php 
 
Customers in the US should send all technical support enquiries to this email 
address: 
 
support-us@thecus.com 
 
 
For Sales Information you can e-mail us at: 
 
sales@thecus.com 
 
 
 
 

Thank you for choosing 
Thecus! 
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http://www.thecus.com/download.php
http://www.thecus.com/support_tech.php
mailto:support-us@thecus.com?subject=N1200%20Support
mailto:sales@thecus.com?subject=N1200%20Support
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Appendix C: RAID Basics 

Overview 
A Redundant Array of Independent Disks (RAID) is an array of several hard disks 
that provide data security and high performance. A RAID system accesses several 
hard disks simultaneously, which improves I/O performance over a single hard 
disk. Data security is enhanced by a RAID, since data loss due to a hard disk 
failure is minimized by regenerating redundant data from the other RAID hard 
disks. 
 

Benefits 
RAID improves I/O performance, and increases data security through fault 
tolerance and redundant data storage. 

Improved Performance 
RAID provides access to several hard disk drives simultaneously, which greatly 
increases I/O performance. 

Data Security 
Hard disk drive failure unfortunately is a common occurrence. A RAID helps 
prevent against the loss of data due to hard disk failure. A RAID offers additional 
hard disk drives that can avert data loss from a hard disk drive failure. If a hard 
drive fails, the RAID volume can regenerate data from the data and parity stored 
on its other hard disk drives. 
 

RAID Levels 
The Thecus M3800 supports standard RAID levels 0, 1, 5, and JBOD. You choose 
a RAID level when you create a system volume. The factors for selecting a RAID 
level are: 
 

• Your requirements for performance 
• Your need for data security 
• Number of hard disk drives in the system, capacity of hard disk drives in 

the system 
 
The following is a description of each RAID level: 

RAID 0 
RAID 0 is best suited for applications that need high bandwidth but do not require 
a high level of data security. The RAID 0 level provides the best performance of 
all the RAID levels, but it does not provide data redundancy.  
 
RAID 0 uses disk striping and breaking up data into blocks to write across all hard 
drives in the volume. The system can then use multiple hard drives for faster 
read and write. The stripe size parameter that was set when the RAID was 
created determines the size of each block. No parity calculations complicate the 
write operation.  
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RAID 1 
RAID 1 mirrors all data from one hard disk drive to a second one hard disk drive, 
thus providing complete data redundancy. However, the cost of data storage 
capacity is doubled.  
 
This is excellent for complete data security. 

RAID 5 
RAID 5 offers data security and good performance. It is best suited for networks 
that perform many small I/O transactions at the same time, as well as 
applications that require data security such as office automation and online 
customer service. Use it also for applications with high read requests but low 
write requests. 
 
RAID 5 includes disk striping at the byte level and parity information is written to 
several hard disk drives. If a hard disk fails the system uses parity stored on each 
of the other hard disks to recreate all missing information. 

JBOD 
Although a concatenation of disks (also called JBOD, or "Just a Bunch of Disks") is 
not one of the numbered RAID levels, it is a popular method for combining 
multiple physical disk drives into a single virtual one. As the name implies, disks 
are merely concatenated together, end to beginning, so they appear to be a 
single large disk. 
 
As the data on JBOD is not protected, one drive failure could result total data loss. 
 

Stripe Size 
The length of the data segments being written across multiple hard disks. Data is 
written in stripes across the multiple hard disks of a RAID. Since multiple disks 
are accessed at the same time, disk striping enhances performance. The stripes 
can vary in size.   

Disk Usage 
When all 3 disks are of the same size, and used in RAID, M3800 disk usage 
percentage is listed below: 
 

RAID Level Percentage Used 
RAID 0 100% 
RAID 1 50% 
RAID 5 66% 
JBOD 100% 
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Appendix D: Active Directory Basics 

Overview 
With Windows 2000, Microsoft introduced Active Directory (ADS), which is a large 
database/information store. Prior to Active Directory the Windows OS could not 
store additional information in its domain database. Active Directory also solved 
the problem of locating resources; which previously relied on Network 
Neighborhood, and was slow. Managing users and groups were among other 
issues Active Directory solved. 

What is Active Directory? 
Active Directory was built as a scalable, extensible directory service that was 
designed to meet corporate needs. A repository for storing user information, 
accounts, passwords, printers, computers, network information and other data, 
Microsoft calls Active Directory a "namespace" where names can be resolved. 

ADS Benefits 
ADS lets the M3800 integrate itself with the existing ADS in an office environment. 
This means the M3800 is able to recognize your office users and passwords on 
the ADS server. Other major benefits ADS support provides include: 
 

1. Easy integration of the M3800 into the existing office IT infrastructure 
 

The M3800 acts as a member of the ADS. This feature significantly lowers 
the overhead of the system administrator. For example, corporate security 
policies and user privileges on an ADS server can be enforced 
automatically on the M3800. 

 
2. Centralized user/password database 
 

The M3800 does not maintain its own copy of the user/password database. 
This avoids data inconsistency between the M3800 and other servers. For 
example, without ADS support, an administrator might need to remove a 
specific user privilege on the M3800 and each individual server. With ADS 
support, the change on an ADS server is known to all of its ADS members. 
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Appendix E: Licensing Information 

Overview 
This product included copyrighted third-party software licensed under the terms 
of GNU General Public License. Please see THE GNU General Public License for 
extra terms and conditions of this license. 

Source Code Availability 
Thecus Technology Corp. has exposed the full source code of the GPL licensed 
software. For more information on how you can obtain our source code, please 
visit our web site, http://www.thecus.com. 
 
Copyrights  
 

• This product includes cryptographic software written by Eric Young 
(eay@cryptsoft.com). 

• This product includes software developed by Mark Murray. 

• This product includes software developed by Eric Young 
(eay@cryptsoft.com). 

• This product includes software developed by the OpenSSL Project for use in 
the OpenSSL Toolkit (http://www.openssl.org/). 

• This product includes PHP, freely available from (http://www.php.net/). 

• This product includes software developed by the University of California, 
Berkeley and its contributors. 

• This product includes software developed by Winning Strategies, Inc. 

• This product includes software developed by the Apache Group for use in 
the Apache HTTP server project (http://www.apache.org/). 

• This product includes software developed by Softweyr LLC, the University 
of California, Berkeley, and its contributors. 

• This product includes software developed by Bodo Moeller. 

• This product includes software developed by Greg Roelofs and contributors 
for the book, "PNG: The Definitive Guide," published by O'Reilly and 
Associates. 

• This product includes software developed by the NetBSD Foundation, Inc. 
and its contributors. 

• This product includes software developed by Yen Yen Lim and North Dakota 
State University. 

• This product includes software developed by the Computer Systems 
Engineering Group at Lawrence Berkeley Laboratory. 

• This product includes software developed by the Kungliga Tekniska 
Högskolan and its contributors. 

• This product includes software developed by the Nick Simicich. 

• This product includes software written by Tim Hudson (tjh@cryptsoft.com). 

• This product includes software developed by Christopher G. Demetriou for 
the NetBSD Project. 

http://www.thecus.com/
mailto:eay@cryptsoft.com
mailto:eay@cryptsoft.com
http://www.openssl.org/
http://www.php.net/
http://www.apache.org/
mailto:tjh@cryptsoft.com
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CGIC License Terms 
Basic License 
 
CGIC, copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by 
Thomas Boutell and Boutell.Com, Inc. 
 
Permission is granted to use CGIC in any application, commercial or 
noncommercial, at no cost. HOWEVER, this copyright paragraph must appear on 
a "credits" page accessible in the public online and offline documentation of the 
program. Modified versions of the CGIC library should not be distributed without 
the attachment of a clear statement regarding the author of the modifications, 
and this notice may in no case be removed. Modifications may also be submitted 
to the author for inclusion in the main CGIC distribution. 

GNU General Public License 
Version 2, June 1991 
 
Copyright © 1989, 1991 Free Software Foundation, Inc. 
51 Franklin St, Fifth Floor, Boston, MA  02110-1301  USA 
 
Everyone is permitted to copy and distribute verbatim copies of this license 
document, but changing it is not allowed. 
 

PREAMBLE 
 
The licenses for most software are designed to take away your freedom to share 
and change it.  By contrast, the GNU General Public License is intended to 
guarantee your freedom to share and change free software--to make sure the 
software is free for all its users.  This General Public License applies to most of 
the Free Software 
Foundation's software and to any other program whose authors commit to using 
it.  (Some other Free Software Foundation software is covered by the GNU Library 
General Public License instead.)  You can apply it to your programs, too. 
 
When we speak of free software, we are referring to freedom, not price.  Our 
General Public Licenses are designed to make sure that you have the freedom to 
distribute copies of free software (and charge for this service if you wish), that 
you receive source code or can get it if you want it, that you can change the 
software or use pieces of it in new free programs; and that you know you can do 
these things. 
 
To protect your rights, we need to make restrictions that forbid anyone to deny 
you these rights or to ask you to surrender the rights. These restrictions translate 
to certain responsibilities for you if you distribute copies of the software, or if you 
modify it. 
 
For example, if you distribute copies of such a program, whether gratis or for a 
fee, you must give the recipients all the rights that you have. You must make 
sure that they, too, receive or can get the source code.  And you must show them 
these terms so they know their rights. 
 
We protect your rights with two steps: (1) copyright the software, and (2) offer 
you this license which gives you legal permission to copy, distribute and/or 
modify the software. 
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Also, for each author's protection and ours, we want to make certain that 
everyone understands that there is no warranty for this free software.  If the 
software is modified by someone else and passed on, we want its recipients to 
know that what they have is not the original, so that any problems introduced by 
others will not reflect on the original authors' reputations. 
 
Finally, any free program is threatened constantly by software patents.  We wish 
to avoid the danger that redistributors of a free program will individually obtain 
patent licenses, in effect making the program proprietary.  To prevent this, we 
have made it clear that any patent must be licensed for everyone's free use or 
not licensed at all. 
 
The precise terms and conditions for copying, distribution and modification follow. 
 

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 
 
0. This License applies to any program or other work which contains a notice 

placed by the copyright holder saying it may be distributed under the terms of 
this General Public License.  The "Program", below, refers to any such 
program or work, and a "work based on the Program" means either the 
Program or any derivative work under copyright law: that is to say, a work 
containing the Program or a portion of it, either verbatim or with modifications 
and/or translated into another language.  (Hereinafter, translation is included 
without limitation in the term "modification".)  Each licensee is addressed as 
"you". 

 
Activities other than copying, distribution and modification are not covered by 
this License; they are outside its scope.  The act of running the Program is not 
restricted, and the output from the Program is covered only if its contents 
constitute a work based on the Program (independent of having been made 
by running the Program). 
 
Whether that is true depends on what the Program does. 

 
1. You may copy and distribute verbatim copies of the Program's source code as 

you receive it, in any medium, provided that you conspicuously and 
appropriately publish on each copy an appropriate copyright notice and 
disclaimer of warranty; keep intact all the notices that refer to this License 
and to the absence of any warranty; and give any other recipients of the 
Program a copy of this License along with the Program. 

 
You may charge a fee for the physical act of transferring a copy, and you may 
at your option offer warranty protection in exchange for a fee. 

 
2. You may modify your copy or copies of the Program or any portion of it, thus 

forming a work based on the Program, and copy and distribute such 
modifications or work under the terms of Section 1 above, provided that you 
also meet all of these conditions: 

 
a) You must cause the modified files to carry prominent notices stating that 

you changed the files and the date of any change. 
 
b) You must cause any work that you distribute or publish, that in whole or in 

part contains or is derived from the Program or any part thereof, to be 
licensed as a whole at no charge to all third parties under the terms of this 
License. 
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c) If the modified program normally reads commands interactively when run, 
you must cause it, when started running for such interactive use in the 
most ordinary way, to print or display an announcement including an 
appropriate copyright notice and a notice that there is no warranty (or else, 
saying that you provide a warranty) and that users may redistribute the 
program under these conditions, and telling the user how to view a copy of 
this License.  (Exception: if the Program itself is interactive but does not 
normally print such an announcement, your work based on the Program is 
not required to print an announcement.) 

 
These requirements apply to the modified work as a whole.  If identifiable 
sections of that work are not derived from the Program, and can be 
reasonably considered independent and separate works in themselves, then 
this License, and its terms, do not apply to those sections when you distribute 
them as separate works.  But when you distribute the same sections as part 
of a whole which is a work based on the Program, the distribution of the whole 
must be on the terms of this License, whose permissions for other licensees 
extend to the entire whole, and thus to each and every part regardless of who 
wrote it. 
 
Thus, it is not the intent of this section to claim rights or contest your rights to 
work written entirely by you; rather, the intent is to exercise the right to 
control the distribution of derivative or collective works based on the Program. 
 
In addition, mere aggregation of another work not based on the Program with 
the Program (or with a work based on the Program) on a volume of a storage 
or distribution medium does not bring the other work under the scope of this 
License. 

 
3. You may copy and distribute the Program (or a work based on it, under 

Section 2) in object code or executable form under the terms of Sections 1 
and 2 above provided that you also do one of the following: 

 
a) Accompany it with the complete corresponding machine-readable source 
code, which must be distributed under the terms of Sections 1 and 2 above on 
a medium customarily used for software interchange; or, 
 
b) Accompany it with a written offer, valid for at least three years, to give 
any third party, for a charge no more than your cost of physically performing 
source distribution, a complete machine-readable copy of the corresponding 
source code, to be distributed under the terms of Sections 1 and 2 above on a 
medium customarily used for software interchange; or, 
 
c) Accompany it with the information you received as to the offer to 
distribute corresponding source code.  (This alternative is allowed only for 
noncommercial distribution and only if you received the program in object 
code or executable form with such an offer, in accord with Subsection b 
above.) 
 
The source code for a work means the preferred form of the work for making 
modifications to it.  For an executable work, complete source code means all 
the source code for all modules it contains, plus any associated interface 
definition files, plus the scripts used to control compilation and installation of 
the executable.  However, as a special exception, the source code distributed 
need not include anything that is normally distributed (in either source or 
binary form) with the major components (compiler, kernel, and so on) of the 
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operating system on which the executable runs, unless that component itself 
accompanies the executable. 
 
If distribution of executable or object code is made by offering access to copy 
from a designated place, then offering equivalent access to copy the source 
code from the same place counts as distribution of the source code, even 
though third parties are not compelled to copy the source along with the 
object code. 

 
4. You may not copy, modify, sublicense, or distribute the Program except as 

expressly provided under this License.  Any attempt otherwise to copy, modify, 
sublicense or distribute the Program is void, and will automatically terminate 
your rights under this License. However, parties who have received copies, or 
rights, from you under this License will not have their licenses terminated so 
long as such parties remain in full compliance. 

 
5. You are not required to accept this License, since you have not signed it.  

However, nothing else grants you permission to modify or distribute the 
Program or its derivative works.  These actions are prohibited by law if you do 
not accept this License.  Therefore, by modifying or distributing the Program 
(or any work based on the Program), you indicate your acceptance of this 
License to do so, and all its terms and conditions for copying, distributing or 
modifying the Program or works based on it. 

 
6. Each time you redistribute the Program (or any work based on the Program), 

the recipient automatically receives a license from the original licensor to copy, 
distribute or modify the Program subject to these terms and conditions.  You 
may not impose any further restrictions on the recipients' exercise of the 
rights granted herein. You are not responsible for enforcing compliance by 
third parties to this License. 

 
7. If, as a consequence of a court judgment or allegation of patent infringement 

or for any other reason (not limited to patent issues), conditions are imposed 
on you (whether by court order, agreement or otherwise) that contradict the 
conditions of this License, they do not excuse you from the conditions of this 
License.  If you cannot distribute so as to satisfy simultaneously your 
obligations under this License and any other pertinent obligations, then as a 
consequence you may not distribute the Program at all.  For example, if a 
patent license would not permit royalty-free redistribution of the Program by 
all those who receive copies directly or indirectly through you, then the only 
way you could satisfy both it and this License would be to refrain entirely from 
distribution of the Program. 

 
If any portion of this section is held invalid or unenforceable under any 
particular circumstance, the balance of the section is intended to apply and 
the section as a whole is intended to apply in other circumstances. 
 
It is not the purpose of this section to induce you to infringe any patents or 
other property right claims or to contest validity of any such claims; this 
section has the sole purpose of protecting the integrity of the free software 
distribution system, which is implemented by public license practices.  Many 
people have made generous contributions to the wide range of software 
distributed through that system in reliance on consistent application of that 
system; it is up to the author/donor to decide if he or she is willing to 
distribute software through any other system and a licensee cannot impose 
that choice. 
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This section is intended to make thoroughly clear what is believed to be a 
consequence of the rest of this License. 

 
8. If the distribution and/or use of the Program is restricted in certain countries 

either by patents or by copyrighted interfaces, the original copyright holder 
who places the Program under this License may add an explicit geographical 
distribution limitation excluding those countries, so that distribution is 
permitted only in or among countries not thus excluded.  In such case, this 
License incorporates the limitation as if written in the body of this License. 

 
9. The Free Software Foundation may publish revised and/or new versions of the 

General Public License from time to time.  Such new versions will be similar in 
spirit to the present version, but may differ in detail to address new problems 
or concerns. 

 
Each version is given a distinguishing version number.  If the Program 
specifies a version number of this License which applies to it and "any later 
version", you have the option of following the terms and conditions either of 
that version or of any later version published by the Free Software Foundation.  
If the Program does not specify a version number of this License, you may 
choose any version ever published by the Free Software Foundation. 

 
10. If you wish to incorporate parts of the Program into other free programs 

whose distribution conditions are different, write to the author to ask for 
permission.  For software which is copyrighted by the Free Software 
Foundation, write to the Free Software Foundation; we sometimes make 
exceptions for this.  Our decision will be guided by the two goals of preserving 
the free status of all derivatives of our free software and of promoting the 
sharing and reuse of software generally. 

 
NO WARRANTY 

 
11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO 

WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE 
LAW.  EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT 
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE 
RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH 
YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF 
ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

 
12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 

WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY 
MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE 
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS 
OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED 
BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE 
WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

 
END OF TERMS AND CONDITIONS 
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	Thank you for choosing the Thecus M3800 IP Storage Appliance. The Thecus M3800 is an easy-to-use storage server that allows a dedicated approach to storing and distributing data on a network. Data reliability is ensured with RAID features that provide data security and recovery—over 3 Terabytes of storage is available. Gigabit Ethernet ports enhance network efficiency, allowing the M3800 to take over file management functions, increase application and data sharing and provide faster data response. The M3800 lets you hot swap working hard drives, securing the continuity of data in the event of hardware failure. The M3800 allows data consolidation and sharing between Windows (SMB/CIFS), UNIX/Linux, and Apple OS X environments. The M3800’s user-friendly GUI supports multiple languages.
	GNU General Public License 100
	Chapter 1: Introduction
	Overview

	First and foremost, the M3800 allows you to store and share files over an IP network. With a Network Attached Storage (NAS) device, you can centralize your files and share them easily over your network. With the easy-to-use web-based interface, users on your network can access these files in a snap.
	Product Highlights
	File Server


	To learn about the Web User Interface, go to Chapter 6: Using the M3800 > Web User Interface.
	With the built-in FTP Server, friends, clients, and customers can upload and download files to your M3800 over the Internet with their favorite FTP programs. You can create user accounts so that only authorized users have access. 
	FTP Server

	To set up the FTP Server, refer to Chapter 5: Additional Feature Setup > FTP Server.
	Don’t leave precious data to chance. With advanced backup capabilities, you can easily upload mission critical files to the M3800, and even automate your backup tasks for true peace-of-mind.
	Backup Server

	To find out how to backup your files with the M3800, refer to Chapter 6: Using the M3800 > File Backup.
	Mediabolic’s Embedded Media Server resides on the M3800 and aggregates personal media so that it was can be accessed by a variety of players, such as network TVs, IP set-top boxes, and digital media adapters. This software is DLNA Certified, which means that increased interoperability with other DLNA certified devices. The software also enables advanced digital rights management, an auto setup wizard, and auto-generating video thumbnails. Mediabolic’s Embedded Media Server makes accessing, sharing, and enjoying your media files easy. 
	Media Server

	To set up the Media Server, refer to Chapter 4: Additional Feature Setup > Media Server.
	Digital music is one of the hottest trends, and with the built-in iTunes® server, you can share your digital music files with every iTunes-equipped PC on your network. The iTunes Server is also incredibly easy to set up! 
	iTunes® Server

	To set up the iTunes Server, refer to Chapter 4: Additional Feature Setup > iTunes Server.
	The Photo Gallery is a great way for friends and family to share precious memories of vacations, birthdays, and more. Users can upload pictures, and even create their own picture albums right on the N1200.
	Photo Gallery

	To set up the Photo Gallery, refer to Chapter 5: Using the M3800 > Using Photo Gallery.
	With the M3800’s Web Cam server, you can schedule the M3800 to capture images from a connected USB webcam at designated intervals. 
	To set up the Web Cam Server, refer to Chapter 5: Additional Feature Setup > Web Cam Server.
	Web Cam Server

	With the M3800’s Printer Server, you can easily share an IPP printer with other PCs connected to your network. 
	To set up the Printer Server, refer to Chapter 5: Additional Feature Setup > Printer Server.
	Printer Server

	M3800 supports schedule power on/off. With this feature, administrator can set at what time to turn on or off the system. This feature is a big plus for people who want to conserve energy. 
	Superior Power Management

	To schedule system on and off, refer to Chapter 4: System Management > System Settings > Reboot and Shutdown System > Scheduled Power On/Off.
	Your M3800 package should contain the following items:
	 Thecus M3800 IP Storage Appliance
	 QIG
	 CD-Title
	 Ethernet Cable
	 Hard drive rails (located behind front panel)
	Package Contents

	 Remote Control
	 AV cable x 2
	Please check to see if your package is complete. If you find that some items are missing, contact your dealer.
	The Thecus M3800’s front panel has the device’s controls, indicators, and hard disk trays:
	Front Panel

	The Thecus M3800’s rear panel features ports and connectors.
	Rear Panel

	Your M3800 is designed for easy installation. To help you get started, the following chapter will help you quickly get your M3800 up and running. Please read it carefully to prevent damaging your unit during installation.
	Chapter 2: Hardware Installation
	Overview

	Before you begin, be sure to take the following precautions:
	1. Read and understand the Safety Warnings outlined in the beginning of the manual.
	2. If possible, wear an anti-static wrist strap during installation to prevent static discharge from damaging the sensitive electronic components on the M3800.
	Before You Begin

	3. Be careful not to use magnetized screwdrivers around the M3800’s electronic components.
	The M3800 supports three standard 3.5” Serial ATA (SATA) hard disks. To install a hard disk into the M3800, follow the steps below:
	1. Remove the front panel of the M3800.
	Hard Disk Installation

	2. Unscrew the thumbscrews which are securing the hard drive rails.
	3. Remove the hard drive rails and install them to your SATA hard disk(s).
	4. Slide hard disks into the M3800 until they snap into place.
	5. Replace the thumbscrews.
	6. Replace the M3800 front cover.
	To connect the M3800 to your network, follow the steps below:
	1. Connect an Ethernet cable from your network to the WAN port on the back panel of the M3800.
	Cable Connections

	2. Connect the provided power cord into the power socket on the back panel. Plug the other end of the cord into a surge protector socket. 
	3. Press the power button on the Front Panel to boot up the M3800. 
	Once the hardware is installed, physically connected to your network, and powered on, you can configure the M3800 so that it is accessible to your network users. Follow the steps below for initial software setup.
	Chapter 3: First Time Setup
	Overview

	The handy Thecus Setup Wizard makes configuring M3800 a snap. To configure the M3800 using the Setup Wizard, perform the following steps:
	1. Insert the installation CD into your CD-ROM drive (the host PC must be connected to the network).
	Thecus Setup Wizard

	2. The Setup Wizard should launch automatically. If not, please browse your CD-ROM drive and double click on Setup.exe.
	3. The Setup Wizard will start and automatically detect all Thecus storage devices on your network. If none are found, please check your connection and refer to Chapter 8: Troubleshooting for assistance.
	4. Select the M3800 that you like to configure. Press Next to continue.
	5. Login with the administrator account and password. The default account and password are both “admin”. Press Next to continue.
	6. Name your M3800 and configure the network IP address. If your switch or router is configured as a DHCP Server, configuring the M3800 to automatically obtain an IP address is recommended. You may also use a static IP address and enter the DNS Server address manually. Press Next to continue.
	7. Enable the desired services. Press Next to continue.
	8. Select the RAID level you wish to use. Press Next to continue.
	9. Change the default administrator password.
	10. Access the M3800 Web Administrator Interface by pressing the Start Browser button. You can also configure another M3800 at this point by clicking the Setup Other Device button. Press Exit to exit the wizard.
	Once the setup wizard has completed, you should now be inside the Web Admin Interface. From here, it is time to initialize your RAID system and install the firmware for the M3800.
	RAID Setup and Firmware Installation

	1. From the Web Admin Interface, navigate to Storage > RAID. The RAID Information screen appears.
	 Click Config.
	2. Select your desired RAID level, and check the checkboxes of the disks you wish to use in your array.
	Setting up the RAID

	3. Select a stripe size – the default is 64K.
	4. Click Create to create your selected RAID volume.
	The M3800 is equipped with an LCD on the front for easy status display and setup. There are four buttons on the front panel to control the LCD functions.
	LCD Operation

	Use the Down (▼), Up (▲), Enter () and Escape (ESC) keys to select various configuration settings and menu options for M3800 configuration. 
	The following table illustrates the keys on the front control panel:
	LCD Controls

	During normal operation, the LCD will be in Display Mode.
	Display Mode

	The M3800 will rotate these messages every three seconds on the LCD display.
	The USB Copy function enables you to copy files stored on USB devices such as USB disks and digital cameras to the M3800 with a press of a button. To use USB copy, follow the steps below:
	USB Copy

	1. Plug your USB device into an available USB port on the Front Panel.
	2. In Display Mode, press the Enter ().
	3. The LCD will display “USB Copy?” 
	4. Press Enter () and the M3800 will start copying USB disks connected to the front USB port. The LCD will display the USB copy progress and results.
	From the Web Administration Interface, you can begin to setup your M3800 for use on your network. Setting up the M3800 typically follows the five steps outlined below.
	Typical Setup Procedure

	For more on how to use the Web Administration Interface, see Chapter 4: System Management > Web Administration Interface.
	From the Web Administration Interface, you can configure the network settings of the M3800 for your network. You can access the Network menu from the menu bar. 
	Step 1: Network Setup

	For details on how to configure your network settings, refer to Chapter 4: System Management > Network Management.
	Next, administrators can configure their preferred RAID setting and build their RAID volume. You can access RAID settings from the menu bar of the Web Administration Interface by navigating to Storage > RAID.
	Step 2: RAID Creation

	For more information on configuring RAID, see Chapter 4: System Management > RAID Configuration.
	Don’t know which RAID level to use? Find out more about the different RAID levels from Appendix C: RAID Basics.
	Once the RAID is ready, you can begin to create local users for the M3800, or choose to setup authentication protocols such as Active Directory (AD).
	Step 3: Create Local Users or Setup Authentication

	For more on managing users, go to Chapter 4: System Management > User and Group Management.
	For more information on configuring Active Directory, see Chapter 4: System Management > User and Group Management > ADS/NT Configuration.
	For information about the benefits of Active Directory, see Appendix D: Active Directory Basics.
	Once users are introduced into your network, you can begin to create various folders on the M3800 and control user access to each using Folder Access Control Lists. 
	Step 4: Create Folders and Set Up ACLs

	More information on managing folders, see Chapter 4: System Management > Folder Management.
	To find out about configuring Folder Access Control Lists, see Chapter 4: System Management > Folder Management > Folder Access Control List (ACL).
	Finally, you can start to setup the different services of the M3800 for the users on your network. You can find out more about each of these services by clicking below:
	Step 5: Start Services

	Windows Networking (SMB/CIFS) iTunes® Server
	Apple File Protocol (AFP)   Media Server
	Network File System (NFS)  Web Cam Server
	File Transfer Protocol (FTP)  Printer Server
	The M3800 provides an easily accessible Web Administration Interface. With it, you can configure and monitor the M3800 anywhere on the network.
	Chapter 4: System Management
	Overview

	Make sure your network is connected to the Internet. To access the M3800 Web Administration Interface:
	1. Type the M3800’s IP address into your browser. (Default IP address is http://192.168.1.100)  
	Web Administration Interface

	2. Login to the system using the administrator user name and password. The factory defaults are: 
	User Name: admin
	Password: admin
	If you changed your password in the setup wizard, use the new password.
	Once you are logged in as an administrator, you will see the Web Administration Interface. From here, you can configure and monitor virtually every aspect of the M3800 from anywhere on the network.
	The Menu Bar is where you will find all of the information screens and system settings of the M3800. The various settings are placed in the following groups on the menu bar:
	Menu Bar

	Moving your cursor over any of these items will display the dropdown menu selections for each group.
	In the following sections, you will find detailed explanations of each function, and how to configure your M3800.
	The M3800 supports multiple languages, including:
	 English
	 French
	 German
	 Italian
	 Traditional Chinese
	 Simplified Chinese
	 Japanese
	 Korean
	 Spanish
	On the menu bar, click Language and the Change Language screen appears. This screen allows you to select preferred language for the M3800. Press Apply to confirm your selection.
	Language Selection

	The Status Menu on the menu bar allows you to see various aspects of the M3800. From here, you can discover the status of the M3800, and even find out other details like firmware version and up time. 
	Status Menu

	Once you login, you will first see the basic Product Information screen providing Manufacturer, Product No., Firmware Version, and Up Time information.
	Product Information

	To access this screen again, navigate to Status > About.
	From the Status menu, choose the System item, and the System Status screen appears. These screens provide basic system status information.
	System Status

	From the Status menu, choose the Printer item, and the Printer Information screen appears. This screen provides the following information about the USB printer connected to the USB port.
	Printer Status

	If a corrupt print job is sent to a printer, printing may suddenly fail. If your print jobs seem to be locked up, pressing the Remove All Documents button to clear the print queue may resolve the issue.
	For information on how to set up the Printer Server, refer to Chapter 5: Additional Feature Setup > Printer Server.
	The M3800 has the ability to be awoken from sleep mode via WAN or LAN. 
	From the Status menu, choose the WOL item, and the Wake-up On Lan Configuration screen appears. From here, you can Enable or Disable Wake-up On WAN and Wake-up On LAN.
	Wake-Up On Lan (WOL)

	The Storage Menu displays the status of storage devices installed in the M3800, and includes storage configuration options such as RAID and disk settings, folder configuration settings. 
	Storage Management

	From the Storage menu, choose the SATA item and the Disks Information screen appears. From here, you can see various items about installed SATA hard disks. Blank lines indicate that a SATA hard disk is not currently installed in that particular disk slot. If there is a problem with a disk, a Failed message will be displayed in the Status column.  
	SATA Information

	From the Storage menu, choose the eSATA item and the eSATA Information screen appears. From here, you can see various items about the eSATA hard disk connected to the M3800, including capacity, used percentage, and model and firmware version. You can even format the connected eSATA hard disk from this menu. 
	eSATA Information

	From the Storage menu, choose the USB item and the USB Information screen appears. From here, you can see various items about USB disks connected to the M3800. 
	USB Disk Information

	From the Storage menu, choose the RAID item and the RAID Information screen appears. 
	This screen lists the RAID volume currently residing on the M3800. From this screen, you can get information about the status of your RAID volume, as well as the status, used percentage, and stripe size.
	RAID Information

	To configure your RAID settings, press the Config button to go to the RAID Configuration screen.
	On the RAID List screen, press the RAID Config button to go to the RAID Configuration screen. In addition to RAID disk information and status, this screen lets you make RAID configuration settings. 
	RAID Configuration

	For more information on RAID, see Appendix C: RAID Basics.
	You can set the storage volume as JBOD, RAID 0, RAID 1, or RAID 5. RAID configuration is usually required only when you first set up the device. A brief description of each RAID setting follows:
	RAID Level

	Using RAID Settings, you can select stripe size, choose which disks are RAID disks or the Spare Disk, as well as enter a name for each disk.
	RAID Settings

	To create a RAID volume, follow the steps below:
	1. On the RAID Configuration screen, set the RAID storage space as JBOD, RAID 0, RAID 1, or RAID 5, — see Appendix C: RAID Basics for a detailed description of each.
	Creating a RAID

	2. Tick the checkboxes of the hard disks you wish to use to create a RAID. 
	3. Specify a stripe size — 64K is the default setting. 
	4. Press Create to build the RAID storage volume.
	With a RAID 1 volume, you can also add a spare disk after the RAID is created. See Chapter 7: Tips and Tricks > Adding a Spare Disk for details.
	To delete a RAID volume, follow the steps below:
	1. On the RAID List screen, select the RAID volume by clicking on its radio button, and click Config to open the RAID Configuration screen.
	Deleting a RAID

	2. On the RAID Configuration screen, click Remove.
	3. The system automatically rebuilds and you can create a new RAID. 
	From the Storage menu, choose Folder, and the Folder screen appears. This screen allows you to create and configure folders on the M3800 volume.
	Folder Management

	On the Folder screen, press the Add button and the Add Folder screen appears. This screen allows you to add a folder. After entering the information, press Apply to create new folder. Press Back to return to the Folder screen.
	Adding Folders

	On the Folder screen, press the Edit button and the Edit Folder screen appears. This screen allows you to change folder information. After entering the information, press Submit to apply the changes. Press Back to return to the Folder screen.
	Editing Folders

	To delete a folder, press the Del button from the specified folder row. The system will confirm folder deletion. Press OK to delete the folder permanently or Cancel to go back to the folder list.
	Deleting Folders

	To allow NFS access to the share folder, enable the NFS Service, and then set up hosts with access rights. Click Add to access the New NFS Share dialogue.
	NFS Share

	On the Folder screen, press the ACL button, and the Access Control List screen appears. This screen allows you to configure access to the specific folder for users and groups. Select a user or a group from the left hand column and then choose Deny, Read Only, or Writable to configure their access level. Press the Submit button to confirm your settings.
	Folder Access Control List (ACL)

	To configure folder access, follow the steps below:
	1. On the ACL screen, all network groups and users are listed in the left hand column. Select a group or user from this list.
	2. With the group or user selected, press one of the buttons from the three access level columns at the top. The group or user then appears in that column and has that level of access to the folder. 
	3. Continue selecting groups and users and assigning them access levels using the column buttons.
	4. To remove a group or user from an access level column, press the Remove button in that column.
	5. When you are finished, press Submit to submit and confirm your ACL settings.
	Use the Network menu to make network configuration settings as well as service support settings.
	From the Network menu, choose WAN, and the WAN Configuration screen appears. This screen displays the network parameters of the WAN connection. You may change any of these items and press Apply to confirm your settings. See a description of each item in the following table:
	Network Management
	WAN Configuration


	The M3800 supports two Gigabit Ethernet ports for higher service availability. To configure these ports, choose LAN from the Network menu, and the LAN Configuration screen appears. Press Apply to save your changes.
	LAN Configuration

	A DHCP server can be configured to assign IP addresses to devices connected to the LAN port. To configure these ports, choose LAN from the Network menu.
	DHCP Configuration

	When a compatible wireless USB dongle is installed on the M3800, the M3800 will become an access point, and the Network dropdown menu will contain a WLAN menu item. From the Network menu, choose WLAN, and the WLAN Configuration screen appears. This screen displays the wireless network parameters of the system. You can to change any of these items and press Apply to confirm your settings. 
	WLAN Configuration
	DDNS Configuration

	From the Network menu, choose the DDNS item, and the DDNS Support screen appears. You can change any of these items and press Apply to confirm your settings. A description of each item follows:
	Typical DDNS Configuration Procedure

	To setup DDNS on your M3800, follow the steps below:
	1. Go to http://www.dyndns.org from your home PC.
	2. Click on the Sign Up Now link.
	3. Check the check boxes, select a user name (i.e.: M3800), enter your email address (i.e.: xxx@example.com), check Enable Wildcard, and create a password (i.e.: xxxx).
	4. Wait for an email from www.dyndns.org.
	5. Open the email and click on the link to activate your account.
	6. Once your account is activated, enter the DDNS server, user name, password, and host name into the DDNS Support screen.
	7. Click Apply to save your changes.
	Web Services Configuration

	From the Network menu, choose the Service item, and the Web Service screen appears. This screen displays the service support parameters of the system. You can change any of these items and press Apply to confirm your settings. A description of each item follows:
	AFP (Apple Network Setup)

	From the Network menu, choose the AFP item, and the AFP Configuration screen appears. This screen displays the configuration items for the Apple Filing Protocol. You can change any of these items and press Apply to confirm your settings. A description of each item follows:
	NFS Setup

	From the Network menu, choose the NFS item, and the NFS Support screen appears. The M3800 can act as an NFS server, enabling users to download and upload files with their favorite NFS clients. Press Apply to confirm your settings. A description of each item follows:
	User and Group Management

	The M3800 has built-in user database that allows administrators to manage user access using different group policies. From the Accounts menu, you can create, modify, and delete users, and assign them to groups that you designate. 
	Local User Configuration

	From the Accounts menu, choose the Users item, and the Local User Configuration screen appears. This screen allows you to Add, Modify, and Delete local users. 
	Adding Users

	Click on the Add button on Local User Configuration screen, and Local User Setting screen appears.
	2. On the Local User Setting screen, enter a name in the User Name box.
	3. Enter a password in the Password box and re-enter the password in the Confirm box.
	4. Select which group the user will belong to. Group Members is a list of groups this user belongs to. Group List is a list of groups this user does not belong to. Use the << or >> buttons to have this user join or leave a group.
	5. Press the Apply button and the user is created.
	Modifying Users

	1. Select an existing user from the Local User Configuration screen.
	2. Click on the Modify button, and Local User Setting screen appears.
	3. From here, you can enter a new password and re-enter to confirm, or use the << or >> buttons to have this user join or leave a group. Click the Apply button to save your changes.
	Deleting Users

	1. Select an existing user from the Local User Configuration screen.
	2. Click on Delete button and the user is deleted from the system.
	Local Groups Configuration

	From the Accounts menu, choose the Groups item, and the Local Groups Configuration screen appears. This screen allows you to Add, Modify, and Delete local groups.
	Adding Groups

	1. On the Local Group Configuration screen, click on the Add button.
	2. The Local Group Setting screen appears.
	3. Enter a Group Name, and select users to be in this group from the Users List by adding them to the Members List using the << button. 
	4. Click the Apply button to save your changes. 
	Modifying Groups

	On the Local Group Configuration screen, select a group name from the list.
	2. Press the Modify button to modify the members in a group.
	3. To add a user into a group, select the user from the Users List, and press the << button to move the user into the Members List.
	4. To remove a user from a group, select the user from Members List, and press the >> button.
	5. Click the Apply button to save your changes.
	Deleting Groups

	1. On the Local Group Configuration screen, select a group name from the list.
	2. Press Delete to delete the group from the system.
	ADS/NT Configuration

	If you have a Windows Active Directory Server (ADS) or Windows NT server to handle the domain security in your network, you can simply enable the ADS/NT support feature; the M3800 will connect with the ADS/NT server and get all the information of the domain users and groups automatically. From the Accounts menu, choose Authentication item and the ADS/NT Support screen appears. You can to change any of these items and press Apply to confirm your settings. A description of each item follows:
	To join an AD domain, you can use the example below to configure the M3800:
	System Settings

	The System menu gives you a wealth of settings that you can use to configure your M3800’s system administration functions. You can set up system notifications, view system logs, and even upgrade firmware from this menu.
	System Notifications

	From the System menu, choose the Notification item, and the Notification Configuration screen appears. This screen lets you have the M3800 notify you in case of any system malfunction. Press Apply to confirm all settings. See following table for a detailed description of each item.
	System Logs

	From the System menu, choose the Logs item and the System Logs screen appears. This screen shows a history of system usage and important events such as disk status, network information, and system booting. See the following table for a detailed description of each item:
	Time and Date Settings

	From the System menu, choose the Time item and the Time screen appears. Set the desired Date, Time, and Time Zone. You can also elect to synchronize the system time on the M3800 with an NTP (Network Time Protocol) Server. You can change any of these items and press Apply to confirm your settings.
	See the following table for a detailed description of each item:
	System Configuration Backup and Restore

	From the System menu, choose the Config Mgmt item and the System Configuration Download/Upload screen appears. From here, you can download or upload stored system configurations. See the following table for a detailed description of each item.
	Module Management

	From the System menu, choose the Module Mgmt item and the Module Management screen appears. From here, you can install separate software modules to extend the functionality of your M3800. 
	Reset to Factory Default Settings

	From the System menu, choose the Factory Default item and the Reset to Factory Default screen appears. Press Apply to reset the M3800 to factory default settings. Press Cancel to go back to the main menu.
	Upgrading System Firmware

	From the System menu, choose the Firmware Upgrade item and the Firmware Upgrade screen appears. 
	Follow the steps below to upgrade your firmware:
	1. Use the Browse button to find the firmware file.
	2. Press Apply.
	3. The beeper beeps and the Busy LED blinks until the upgrade is complete.
	Change Administrator Password

	From the System menu, choose the Administrator Password item and the Change Administrator Password screen appears. Enter a new password in the New Password box and confirm your new password in the Confirm Password box. Press Apply to confirm password changes. See the following table for a detailed description of each item.
	Reboot and Shutdown System

	From the System menu, choose Reboot & Shutdown item, and the Shutdown/Reboot System screen appears. Press Reboot to restart the system or Shutdown to turn the system off.
	Scheduled Power On/Off

	You may also designate a schedule for the M3800 to turn on and off. To do this, first enable the feature by checking the Enable Timer checkbox. Then, simply choose an on and off time for each day of the week that you would like to designate a schedule by using the various dropdowns. Finally, click Apply to save your changes.
	Example - Monday: On: 8:00; Off: 16:00
	System will turn on at 8:00 AM on Monday, and off at 16:00 on Monday. System will turn on for the rest of the week.
	If you choose an on time, but do not assign an off time, the system will turn on and remain on until a scheduled off time is reached, or if the unit is shutdown manually.
	Example - Monday: On: 8:00
	System will turn on at 8:00 AM on Monday, and will not shut down unless powered down manually.
	You may also choose two on times or two off times on a particular day, and the system will act accordingly.
	Example - Monday: Off: 8:00; Off: 16:00
	System will turn off at 8:00 AM on Monday. System will turn off at 16:00 PM on Monday, if it was on. If the system was already off at 16:00 PM on Monday, system will stay off.
	TV Setup

	One of very unique feature of M3800 is HDMI/AV out direct connection to TV. They are varies options can be setup, please refer the document “M3800 OSD User’s Manual” for more details. 
	Logout

	To logout of the Web Administration Interface, navigate to System > Logout.
	Chapter 5: Additional Feature Setup
	FTP Server

	M3800 can act as a FTP server, enabling users to download and upload files with their favorite FTP programs. From the Network menu, choose the FTP item, and the FTP screen appears. You can change any of these items and press Apply to confirm your settings. A description of each item follows: 
	To access the share folder on the M3800, use the appropriate user login and password set up on the Users page (Accounts > Users). Access control to each share folder is set up on the ACL page (Storage > Folder > ACL).
	When trying to access M3800 anonymously, just enter “anonymous” as the user name.
	iTunes® Server

	With the built-in iTunes server capability, the M3800 enables digital music to be shared and played anywhere on the network! 
	From the Network menu, choose the iTunes item, and the iTunes Configuration screen appears. You may enable or disable the iTunes Service from here. Once enabled, enter correct information for each field and press Apply to save your changes. See the following table for detailed descriptions of each field: 
	Once the iTunes service is enabled, the M3800 will make all music located in the Music folder available for iTunes-equipped computers on the network.
	Media Server

	With the built-in Media Server capability, the M3800 provides media streaming service to stand-alone networked home media adapters that support the UPnP AV protocol or are Digital Living Network Alliance (DLNA) standard compliant. 
	With the M3800’s built-in media server capability, you can share digital media such as music, pictures, and movies with any compatible device throughout your entire home.
	To configure the media server, under the Network menu, click Media Server and the Media Manager Settings window will appear. A description of each field follows:
	Adding Media Share Folders

	Once the Media Server software is installed, you can start adding folders that contain the media that you would like to share. To create a media share folder, follow the steps below:
	1. Click on Network > Media Server in the menu bar. 
	2. From the Shared Media Folders window, select the folder that contains your media files, and click its checkbox.
	3. The contents in the folder will be scanned for the Media Server. The time required for scanning depends on the size of the folder.
	Connecting DMAs to the Media Server

	Next, it’s time to connect your Digital Media Adapter (DMA) to the media server:
	1. Connect your DMA to your Media Server
	a. Configure your DMA to use a Dynamic IP address. The IP address will be assigned by the router.
	b. Some DMAs are wireless enabled. You can connect the DMA to a wireless router. For instructions on how to connect your DMA to a wireless router, please refer to your DMA’s user manual.
	2. Connect your DMA’s video output to video input of your TV set.
	3. Turn on the TV and change the video signal input to DMA.
	4. Setup the DMA (These steps will be different if you use a different DMA)
	a. From the Server List screen, select “M3800:Mediabolic Server” as the server.
	b. Go to My Media
	c. Click on the Up/Down Arrow buttons to select Music Jukebox, Photo Albums, or Video Clips
	d. Start enjoying the contents stored in your M3800.
	Download Manager

	With the built-in Download Manager, you can have the M3800 download HTTP, FTP, and BT files without having full PC powered on. What’s more, you can even schedule your downloads for off-peak hours, ensuring efficient use of bandwidth. To access the Download Manager, go to Network, choose the Download Manager option, and the Download Tasks and Download Schedule windows appear. 
	Adding an HTTP Task

	To add a new HTTP task to the Download Manager, follow these steps:
	1. Using the Task Type dropdown, select HTTP and click Add Task. 
	2. In the HTTP Task window, start by inputting the target URL in the Website URL box. This is the link to the download you want to queue.
	3. Next, select the destination folder from the Destination Folder dropdown. This is where the download will reside.
	4. Select the maximum download bandwidth from the Max. Download Bandwidth dropdown.
	5. Press Apply to add the task.
	6. Once added, your download will appear in the list of download tasks. To start the download, simply click the Start icon () and the download will begin.
	7. The download status will continually update in the Download Tasks window. To pause the download, click the Pause icon (). 
	Adding an FTP Task

	To add a new FTP task to the Download Manager, follow these steps:
	1. Using the Task Type dropdown, select FTP and click Add Task. 
	2. In the FTP Task window, start by inputting the target URL in the FTP File box. This is the link to the download you want to queue.
	3. Next, select the destination folder from the Destination Folder dropdown. This is where the download will reside.
	4. The next step depends if you are using an anonymous login for your FTP download. If you are logging in anonymously, select Anonymous Login and move on to step 5.
	If you are required to login with a user name and password, select Username and input your user name and password into the appropriate fields. 
	5. Select the maximum download bandwidth from the Max. Download Bandwidth dropdown.
	6. Press Apply to add the task.
	7. Once added, your download will appear in the list of download tasks. To start the download, simply click the Start icon () and the download will begin.
	8. The download status will continually update in the Download Tasks window. To pause the download, click the Pause icon (). 
	Adding a BT Task

	To add a new BT task to the Download Manager, follow these steps:
	1. Using the Task Type dropdown, select BT and click Add Task. 
	2. In the BT Task window, start by clicking Browse… and selecting the torrent file you wish to start.
	3. Next, select the destination folder from the Destination Folder dropdown. This is where the download will reside.
	4. Next, you can select the maximum and minimum number of peers from selecting the counts from the appropriate dropdowns.
	5. Next, you can set the maximum download and upload bandwidths from the dropdowns below.
	6. Press Apply to add the task.
	7. Once added, your download will appear in the list of download tasks. To start the download, simply click the Start icon () and the download will begin.
	8. The download status will continually update in the Download Tasks window. To pause the download, click the Pause icon (). 
	Deleting Tasks

	To delete a task, simply follow the steps below:
	1. Click the delete icon () beside the task that you wish to delete. The Delete Task dialogue box will appear.
	2. Select Delete Task only if you wish to remove only the torrent file and all transient files, leaving the unfinished download files intact.
	3. Select Delete Task and Files if you wish to remove the torrent file and all transient files, and the unfinished download files.
	4. Click OK to delete the task. Click Cancel to return to the Download Manager.
	Scheduling Downloads

	With the Download Manager, you can schedule your downloads to begin at different times of the day. This is useful if you wish to complete your downloads during off-peak hours, reserving your bandwidth for other applications. A table describing the Download Schedule window appears below:
	To schedule downloads, follow these steps:
	1. Under Download Schedule, set Scheduler to Enable.
	2. To schedule a daily download period, select Daily and select a start time and end time. 
	To schedule a weekly download period, select Weekly and select a start day/time and end time/day. 
	3. Click Apply to save your changes.
	Web Cam Server

	With the Web Cam Server, you can schedule the N3200PRO to capture images with a connected USB webcam. To configure the Web Cam Server, go to Status, choose the Web Camera option, and the Web Camera window appears. 
	Web Cam Preview

	From the Web Camera window, you can click the Preview button to view the image from the Web Cam before setting up the recording schedule if you wish.
	Note:
	Picture quality may vary due to the number of different USB Web Cams on market with varying hardware components.
	Once you are happy with the Web Cam preview, your can select the resolution you want. There are 3 different choices:
	 160x120
	 320x240
	 640x480
	Use the drop down to select the desired recording interval. 
	Click Apply to save your changes. 
	Adding a Web Cam Schedule

	After finishing with the basic settings, we need to now configure the capture schedule. To do this, begin by activating the schedule function by selecting Enable in the Web Camera Schedule window. 
	Next, select time slot you want to record through the Web Cam. 
	If Always is selected, it will start to record right away and will not stop until the Web Camera Schedule is set to Disabled. 
	Alternatively, you can schedule the Web Cam to capture daily or hourly. Take a look at the example below. It will record every Monday and Tuesday from 2:00 – 6:00 and from 20:00 – 22:00. 
	One important point worth mentioning is how captured picture is stored. The folder where captured images are stored is the Video system folder, which is associated with the system-created Web Cam sub folder. See the figure below for reference:
	The Web Cam will capture images according to the designated schedule. The files will be stored using following path:
	Video + Webcam + date + hour (path)( filename.jpg
	Printer Server

	You can configure the M3800 to act as a printer server. That way, all PCs connected to the network can utilize the same printer. 
	Windows XP SP2

	To set up the Printer Server in Windows XP SP2, follow the steps below:
	1. Connect the USB printer to one of the USB ports (preferably the rear USB ports; front USB ports can be used for external HDD enclosures).
	2. Go to Start > Printers and Faxes.
	3. Click on File > Add Printer.
	4. The Add Printer Wizard appears on your screen. Click Next.
	5. Select the “A network printer, or a printer attached to another computer” option.
	6. Select “Connect to a printer on the Internet or on a home or office network”, and enter “http://M3800_IP_ADDRESS:631/printers/usb-printer” into the URL field.
	7. Your Windows system will ask you to install drivers for your printer. Select correct driver for your printer.
	8. Your Windows system will ask you if you want to set this printer as “Default Printer”. Select Yes and all your print jobs will be submitted to this printer by default. Click Next.
	9. Click Finish.
	Windows Vista

	To set up the Printer Server in Windows Vista, follow the steps below:
	1. Open Printer Folder from the Control Panel.
	2. Click the right mouse button in anywhere on the Printers folder and then select Add Printer.
	3. Select Add a network, wireless or Bluetooth printer.
	4. Select The printer that I want isn’t listed.
	You can press The printer that I want isn’t listed to go into next page without waiting for Searching for available printers to finish.
	5. Click Select a shared printer by name.
	Type http://<Thecus_NAS>:631/printers/usb-printer in the box, where <Thecus_NAS_IP> is the IP address of the M3800. Click Next.
	6. Select or install a printer and then press OK.
	If your printer model is not listed, please contact your printer manufacturer for help.
	7. Windows will attempt to connect to the printer.
	8. You can choose to set this printer as the default printer by checking the Set as the default printer box. Click Next to continue.
	9. Done! Click Finish.
	Chapter 6: Using the M3800
	Overview

	Once the M3800 is setup and operating, users on the network may manage all varieties of digital music, photos, or files by simply using their web browsers. To manage your personal files or access public files on the M3800, just enter its IP address into your browser (default IP address is http://192.168.1.100), and you will be taken to the M3800 Login page.
	Login Page

	To login to the system, enter your user name and password, and click Login to log into the system. You will be taken to the Web User Interface.
	Web User Interface

	The Web User Interface is where users interact with the M3800, and manage all sorts of digital media. The simple layout makes it easy for anyone to enjoy the many features of the M3800. 
	On the left of the interface is the Main Menu, where you can easy access the WebDisk, Music, and Gallery functions of the M3800. Along the top of the interface, you to choose to browse all storage devices connected to the M3800, including SATA and eSATA hard disks, USB disks, and contents stored from the USB One-Button Copy function.
	Using WebDisk

	1. When any user clicks on the WebDisk icon, they will see all available public folders.
	2. When they click on the name of a public folder, they will see the files within that folder. 
	3. When user clicks on a file name, the file will be downloaded.
	For more information on how to setup user rights to the folders, please check Chapter 3: System Management > Storage Management > Folder Management > Folder Access Control List (ACL) 
	To access folders with access control, you must first login with a local user account. To log in, please click on the Login icon on the lower left hand corner.
	Using Music Server

	To manage your digital music and share it with iTunes clients on the network, click on the Music icon from the left panel.
	Adding Music Files

	You could add music files into iTunes Server through Web User Interface; however, if you have lots of folders and files to upload, there is a simpler way.
	1. Open a Windows Explorer and type the M3800 IP address in the address bar (i.e. \\192.168.1.100).
	2. Double click the Music folder to enter it. Then drag and drop music folders and files here.
	3. The M3800 iTunes server will take some time to cache the ID3 tag of every file. Once the process is done, you will see all the music files from iTunes clients.
	Playing Music Files

	Once your music files are added to the M3800, playing them on any iTunes-equipped computer connected to the network is easy:
	1. Open iTunes.
	2. You should see Thecus_M3800 under the SHARED heading in the left hand menu.
	3. Click Thecus_M3800 and all shared music will be displayed, ready to be enjoyed right from iTunes.
	Using Photo Gallery

	Using the Photo Gallery, users can view and share photos, and even create their own albums right on the M3800. To manage your photo gallery or see other photo albums, click on the Photos icon from the left panel.
	You will see your own Photo Gallery and all public Photo Albums on the network.
	To manage any picture files, you must first select the item by clicking its check box.
	Managing Albums and Photos
	Creating Albums

	To create a photo album, follow the steps below:
	1. Click the Add button to create a new album.
	2. Enter a name for the album, and enter a description if you wish. Then, click on the Create Album button.
	Password Protecting Albums

	If you would like to put a password on a particular album, follow these steps:
	1. Select the album to be protected, click on the Edit button, and the Album Edit screen will appear. 
	2. The owner of the album can enter an album password to protect the album, so that only people with the correct password can view the album. 
	Uploading Pictures to Albums

	Uploading pictures to albums using the Web User Interface is easy:
	1. When the album is created, click the album icon to enter the album. Initially the album is empty. 
	2. Click the Add button to upload pictures into the album. The Upload Photos screen will appear. Users can select and upload up to 8 pictures at a time.
	3. Once the picture is uploaded, you can view it in the album. 
	4. The owner of the album can delete or modify the pictures with the Delete or Modify buttons on the top right hand corner. 
	Windows XP Publishing Wizard

	There are many ways for a local user to upload pictures into their photo album. Users of Windows XP can upload their pictures using the Windows XP Publishing Wizard.
	1. Click on the XP Publishing Wizard icon.
	2. The XP Web Publishing Wizard Client screen appears. Click on the link to install the Publishing Wizard. 
	3. Windows XP will ask whether you want to run or save this file. Click Run.
	4. Once the Wizard is installed, use the Windows file manager to browse the folder that contains the picture you want to publish. On the left pane, there will be an icon labeled “Publish this folder to the Web”. 
	5. Click on this icon and Web Publishing Wizard will start. 
	6. Select the pictures you want to publish to the Photo Web Server by placing a check mark on the top left hand corner of the picture. Click Next. 
	7. Your PC will start to connect to the Photo Web Server.
	8. Select M3800 Photo Gallery Wizard to publish your pictures to the M3800. 
	9. Login into the M3800 with your local user name and password.
	10. Create your album by entering an album name and clicking on the Create Album button. 
	10. Select the album you want to upload your pictures to.
	11. Confirm the target album. 
	12. Windows will show you that the picture upload is in progress.
	13. When the upload is finished, the Wizard will ask you whether if you want to go to the website. Click Finish to go to your Photo Web Server.
	14. Click on the user’s icon to go to that user’s album. 
	15. You will see the user’s album list. Click on user. 
	16. Finished! You will see the pictures just selected in the album. 
	EXIF Information

	While viewing pictures, you can also have the M3800 display the EXIF information for each photo.
	Simply click the EXIF button to display EXIF information. To hide this information, click the EXIF button again.
	Slide Shows

	Slide shows are a great way to enjoy pictures stored on your M3800. 
	You can click on the Start Slide Show icon on the top right hand corner to start the slide show.
	To stop the slide show, click on the Stop Slide Show icon on the top right hand corner. 
	Mapping a Client PC to the M3800

	You can map share folders on the M3800 so that you can access them as if they were drives on your computer. You can connect to the shared network folders on the M3800 as follows: 
	Windows

	1. Go to the My Computer folder in Windows.
	2. In the menu bar, select Tools and then Map Network Drive…
	3. The Map Network Drive window appears.
	4. Assign a drive letter for the share folder.  
	5. Click the Browse button to find the folder over your network. Alternatively, you may enter the folder name you wish to connect to or enter its IP address. (i.e. \\192.168.1.100\share)
	6. Click Finish. When the Connect As… window appears, enter your user name and password.
	7. Click OK. The share folder appears as the drive you assigned. You can now access this folder as though it were a drive on your computer. 
	Apple OS X

	On an Apple computer, you can connect to shared computers and servers using a network address. 
	1. Choose Go > Connect to Server…
	2. Enter the network address for the server in the Server Address text box.
	When connecting using SMB/CIFS protocol, type:
	smb://192.168.1.100/Folder1
	When connecting using AFP protocol, type:
	afp://192.168.1.100/Folder1
	Click Connect.
	3. When MAC OS X is trying to connect M3800, it will ask for a User Name and Password which has access to the folder.
	4. When MAC OS X has connected to the M3800 successfully, an icon representing the folder will appear on the MAC OS X desktop. You can access the folder by double clicking on the icon.
	File Backup

	There are a number of ways to back up data with the M3800. 
	Thecus Backup Utility

	The Thecus Backup Utility is on your Installation CD. When you click on the CD, the Backup Utility will be installed under Program Groups > Thecus > Thecus Backup Utility. If it is not installed, you can copy the file (Thecus Backup Utility.exe) to a convenient location on your hard disk and double click to execute it.
	When you execute this utility for the first time, it will ask you whether to create a DB file. Click Yes.
	1. Click Add to create a Backup task. The Add New Task dialog box appears.
	2. To schedule the task to run at regular intervals, click on the Schedule icon for that task. You can schedule the task to run Monthly or Weekly.
	3. To check the log for that task, click on the Log icon for that task.
	Windows XP Data Backup

	If you use Windows XP Professional, you can also use the Windows Backup Utility (Ntbackup.exe) to backup your files.
	If you use Windows XP Home Edition, follow these steps to install the utility:
	1. Insert the Windows XP CD into a drive and double-click the CD icon in My Computer.
	2. When the Welcome to Microsoft Windows XP screen appears, click Perform Additional Tasks. 
	3. Click Browse this CD. 
	4. In Windows Explorer, navigate to ValueAdd > Msft > Ntbackup. 
	5. Double-click Ntbackup.msi to install the backup utility.
	Once installed, you can use the Windows Backup Utility by following the steps below:
	1. Click Start, and point to All Programs > Accessories > System Tools > Backup to start the wizard.
	2. Click Next to skip past the opening page. Choose Backup files and settings from the second page, and then click Next. 
	3. Select which option you want to back up.
	4. Click Next and in the Backup Type, Destination, and Name page, specify a back up location using the Browse button.
	5. Find and select the drive that specifies your M3800 as your backup destination and click Next.
	6. Click Next to display the wizard’s final page and click Finish to start backing up. 
	Apple OS X Backup Utilities

	Mac OS X does not include any backup software. However, there are a number of backup solutions available for the Mac OS X, including: iBackup, Psyncx, iMSafe, Rsyncx, Folder Synchronizer X, Tri-BACKUP, Impression, Intego Personal Backup, SilverKeeper, and Apple's dotMac Backup utility to name just a few. To find even more freeware and shareware backup utilities to choose from, go to VersionTracker or MacUpdate and search on "backup".
	Chapter 7: Tips and Tricks
	USB and eSATA Storage Expansion

	The M3800 supports external USB hard disks through its three USB ports. Once a USB hard disk has successfully mounted, the entire volume will be copied automatically to the default USB HDD folder. The M3800 supports up to 6 USB external storage devices. All file names on the USB disk volume are case sensitive.
	The M3800 also supports eSATA hard disks with its eSATA port.
	Before attaching an eSATA or USB disk drive to M3800, you have to partition and format it on a desktop computer or a notebook first. The attached device will be located at \\192.168.1.100\usbhdd\sdf1 where 192.168.1.100 means the IP address of M3800 and sdf1 stands for the first partition on disk #6, the eSATA or USB disk drive. If it is an NTFS partition, NAS users can open or copy files from \\192.168.1.100\usbhdd\sdf1 but cannot add new files or modify existing files. 
	Adding a Spare Disk 

	With a RAID 1 array, you can add a spare disk after the initial RAID is setup. To add a spare disk, follow the steps below:
	1. On the RAID Configuration Screen, tick the checkbox of the hard disk you wish to designate as a spare disk.
	2. Click Add Spare. 
	Once the disk is set as a spare disk, it will automatically rebuild the previous RAID set when one of the disks becomes degraded.
	Remote Administration

	You can set up your M3800 for remote administration. With remote administration, you can access your M3800 over the Internet, even if your M3800 is behind a router. This is especially useful if you are traveling and suddenly need a file from your M3800. 
	Setting up remote administration is a three-part process, and will require the following equipment:
	 Thecus M3800 NAS device
	 Cable/DSL Router with Dynamic DNS support
	 Home PC
	 Internet Connection
	Part I - Setup a DynDNS Account

	1. Go to http://www.dyndns.org from your home PC.
	2. Click on the Sign Up Now link.
	3. Check the Check boxes, select a user name (i.e.: M3800), enter your email address (i.e.: xxx@example.com), check Enable Wildcard, and create a password (i.e.: xxxx).
	4. Wait for an email from www.dyndns.org.
	5. Open the email and click on the link to activate your account
	Part II - Enable DDNS on the Router

	1. Go to the router setup screen and select IP Config > Miscellaneous DDNS Setting from your Home PC.
	2. Click on Yes for Enable the DDNS Client?
	3. Select www.dyndns.org.
	4. Go to router setup screen, and enter the following information:
	a. User Name or E-mail Address: xxx@example.com
	b. Password or DDNS Key: xxxx
	c. Host Name: www.M3800.dyndns.org
	d. Enable wildcard? Select Yes
	e. Update Manually: Click Update
	Part III - Setting up Virtual Servers (HTTPS)

	1. Navigate to NAT Setting > Virtual Server.
	2. For Enable Virtual Server?, select Yes
	3. Setup the HTTPS Server
	a. Well-Known Applications: Select User Defined
	b. Local IP: Enter 192.168.1.100
	c. Port Range: 443 (the default HTTPS port setting on the M3800)
	d. Protocol: select TCP
	e. Click Add.
	f. Click Apply.
	4. Test the HTTPS connection from another computer on the Internet
	a. From a remote computer, open your browser and enter https://www.M3800.dyndns.org
	b. You should see the login page of M3800.
	Firewall Software Configuration

	If you are using a software firewall (i.e. Norton Internet Security) and are having trouble connecting to the M3800, you can try the following steps:
	1. Double click the NIS icon on system tray, and then configure the Personal Firewall.
	2. On the Programs page, find the SetupWizard.exe and change its permission to "Permit All". If it's not in the program list, use the Add or Program Scan buttons to find it.
	3. On the Networking page, manually add M3800 IP address (i.e. 192.168.1.100) to the Trusted list. 
	Replacing Damaged Hard Drives

	If you are using RAID 1 or RAID 5, you can easily replace a damaged hard drive in the Thecus M3800 while keeping your data secure with the system’s automatic data recovery. 
	Hard Drive Damage

	When a hard drive is damaged, LCM will display「RAID Damage」and system beeps.
	Replacing a Hard Drive 

	To replace a hard disk drive in the M3800:
	1. Remove the tray with the damaged hard disk.
	2. Insert the hard disk tray then slide into the M3800 until it snaps into place. 
	3. The LED solid green when the HDD is accessed.
	RAID Auto-Rebuild

	When using RAID 1 or RAID 5 on the M3800, you can use the auto-rebuild function when an error is detected. 
	1. When a hard disk fails the system beeps and/or an email notification is sent to specified receivers.
	2. Check the log message to see which disk has failed.
	3. Follow the steps mentioned above to replace the failed hard disk.
	4. The system automatically recognizes the new hard disk and starts the auto-rebuild sequence to resume its status before the hard disk crash.
	File System Check

	The M3800 has a built-in utility that allows you to check the M3800’s file system for errors. To use the File System Check utility, follow the steps below:
	1. Power off the M3800.
	2. With the unit powered off, press and hold the reset button. 
	3. With the reset button held down, power on the system by pressing the power button. You can release the reset button after 3 seconds alone with 2 beeps. After that, the M3800's WAN IP address will be reset to 192.168.1.100 temporarily. Please note that all file services at this time will be stopped.
	4. When you point your browser to 192.168.1.100, you will see the following screen.
	5. If you select “Run file system check” option, the file system check utility will be started, and last 20 lines of the result will be displayed in your browser.
	6. When the file system check is finished, the result will be displayed in your browser.
	Chapter 8: Troubleshooting
	Forgot My Network IP Address

	If you forget your network IP address and have no physical access to the system, you can find out the IP address by either looking directly onto the M3800’s LCD panel, or by using the setup wizard to retrieve the IP of your M3800.
	1. Start the Setup Wizard, and it will automatically detect all Thecus IP storage products on your network.
	2. You should be able to find the IP address of the M3800 which you have forgotten in the Device Discovery screen.
	Resetting NAS IP Address and Admin Password

	In case you changed the M3800 IP address and then forgot it, or forgot the administration password, follow the steps below to reset to default settings: 
	1. Power on the M3800 and immediately press the Reset button for 5 seconds. (The reset button is near the LAN connector)
	2. This resets the M3800 to its default IP address and password settings. 
	Default IP: 192.168.1.100 for WAN and 192.168.2.254 for LAN
	Default admin password: admin
	Jumbo Frame support: disabled 
	Can't Map a Network Drive in Windows XP

	You may have problems mapping a network drive under the following conditions:
	1. The network folder is currently mapped using a different user name and password. To connect using a different user name and password, first disconnect any existing mappings to this network share.
	2. The mapped network drive could not be created because the following error has occurred: Multiple connections to a server or shared resource by the same user, using more than one user name, are not allowed. Disconnect all previous connections to the server or shared resource and try again.
	To check out existing network connections, type net use under the DOS prompt. 
	Restoring Factory Defaults

	From the System menu, choose the Factory Default item and the Reset to Factory Default screen appears. Press Apply to reset the M3800 to factory default settings.
	Problems with Time and Date Settings

	The administrator is able to select an NTP Server to keep the M3800’s time synchronized. However, if the M3800 can not access the Internet, you may encounter a problem when setting the Time and Time Zone. If this happens:
	1. Login to the Web Administration Interface.
	2. Navigate to System > Time.
	3. Under NTP Server, select No.
	4. Set the Date, Time, and Time Zone.
	5. Click Apply.
	In addition, if the M3800 is able to access the Internet and you want to keep the NTP Server clock.isc.org by default, please make sure the DNS Server is correctly entered, thereby allowing the NTP Server name to correctly resolve. (See Network > WAN > DNS Server)
	Appendix A: Product Specifications
	Hardware Specifications
	Software Specifications

	*PDC/AD support: Works as a client member in a Microsoft NT 4.0 domain/Active Directory domain, allowing the M3800 to utilize the domain users and groups setting for authentication to the system and authorization to the share folders.
	**For supported USB dongles, please contact sales@thecus.com
	Appendix B: Customer Support
	If your M3800 is not working properly, we encourage you to check out Chapter 8: Troubleshooting, located in this manual. You can also try to ensure that you are using the latest firmware version for your M3800. Thecus is committed to providing free firmware upgrades to our customers. Our newest firmware is available on our Download Center:
	http://www.thecus.com/download.php
	If you are still experiencing problems with your M3800, or require a Return Merchandise Authorization (RMA), feel free to contact technical support via our Technical Support Website:
	http://www.thecus.com/support_tech.php
	Customers in the US should send all technical support enquiries to this email address:
	support-us@thecus.com
	For Sales Information you can e-mail us at:
	sales@thecus.com
	Thank you for choosing Thecus!
	Appendix C: RAID Basics
	Overview

	A Redundant Array of Independent Disks (RAID) is an array of several hard disks that provide data security and high performance. A RAID system accesses several hard disks simultaneously, which improves I/O performance over a single hard disk. Data security is enhanced by a RAID, since data loss due to a hard disk failure is minimized by regenerating redundant data from the other RAID hard disks.
	Benefits

	RAID improves I/O performance, and increases data security through fault tolerance and redundant data storage.
	Improved Performance

	RAID provides access to several hard disk drives simultaneously, which greatly increases I/O performance.
	Data Security

	Hard disk drive failure unfortunately is a common occurrence. A RAID helps prevent against the loss of data due to hard disk failure. A RAID offers additional hard disk drives that can avert data loss from a hard disk drive failure. If a hard drive fails, the RAID volume can regenerate data from the data and parity stored on its other hard disk drives.
	RAID Levels

	The Thecus M3800 supports standard RAID levels 0, 1, 5, and JBOD. You choose a RAID level when you create a system volume. The factors for selecting a RAID level are:
	 Your requirements for performance
	 Your need for data security
	 Number of hard disk drives in the system, capacity of hard disk drives in the system
	The following is a description of each RAID level:
	RAID 0

	RAID 0 is best suited for applications that need high bandwidth but do not require a high level of data security. The RAID 0 level provides the best performance of all the RAID levels, but it does not provide data redundancy. 
	RAID 0 uses disk striping and breaking up data into blocks to write across all hard drives in the volume. The system can then use multiple hard drives for faster read and write. The stripe size parameter that was set when the RAID was created determines the size of each block. No parity calculations complicate the write operation. 
	RAID 1

	RAID 1 mirrors all data from one hard disk drive to a second one hard disk drive, thus providing complete data redundancy. However, the cost of data storage capacity is doubled. 
	This is excellent for complete data security.
	RAID 5

	RAID 5 offers data security and good performance. It is best suited for networks that perform many small I/O transactions at the same time, as well as applications that require data security such as office automation and online customer service. Use it also for applications with high read requests but low write requests.
	RAID 5 includes disk striping at the byte level and parity information is written to several hard disk drives. If a hard disk fails the system uses parity stored on each of the other hard disks to recreate all missing information.
	JBOD

	Although a concatenation of disks (also called JBOD, or "Just a Bunch of Disks") is not one of the numbered RAID levels, it is a popular method for combining multiple physical disk drives into a single virtual one. As the name implies, disks are merely concatenated together, end to beginning, so they appear to be a single large disk.
	As the data on JBOD is not protected, one drive failure could result total data loss.
	Stripe Size

	The length of the data segments being written across multiple hard disks. Data is written in stripes across the multiple hard disks of a RAID. Since multiple disks are accessed at the same time, disk striping enhances performance. The stripes can vary in size.  
	Disk Usage

	When all 3 disks are of the same size, and used in RAID, M3800 disk usage percentage is listed below:
	Appendix D: Active Directory Basics
	Overview

	With Windows 2000, Microsoft introduced Active Directory (ADS), which is a large database/information store. Prior to Active Directory the Windows OS could not store additional information in its domain database. Active Directory also solved the problem of locating resources; which previously relied on Network Neighborhood, and was slow. Managing users and groups were among other issues Active Directory solved.
	What is Active Directory?

	Active Directory was built as a scalable, extensible directory service that was designed to meet corporate needs. A repository for storing user information, accounts, passwords, printers, computers, network information and other data, Microsoft calls Active Directory a "namespace" where names can be resolved.
	ADS Benefits

	ADS lets the M3800 integrate itself with the existing ADS in an office environment. This means the M3800 is able to recognize your office users and passwords on the ADS server. Other major benefits ADS support provides include:
	1. Easy integration of the M3800 into the existing office IT infrastructure
	The M3800 acts as a member of the ADS. This feature significantly lowers the overhead of the system administrator. For example, corporate security policies and user privileges on an ADS server can be enforced automatically on the M3800.
	2. Centralized user/password database
	The M3800 does not maintain its own copy of the user/password database. This avoids data inconsistency between the M3800 and other servers. For example, without ADS support, an administrator might need to remove a specific user privilege on the M3800 and each individual server. With ADS support, the change on an ADS server is known to all of its ADS members.
	Appendix E: Licensing Information
	Overview

	This product included copyrighted third-party software licensed under the terms of GNU General Public License. Please see THE GNU General Public License for extra terms and conditions of this license.
	Source Code Availability

	Thecus Technology Corp. has exposed the full source code of the GPL licensed software. For more information on how you can obtain our source code, please visit our web site, http://www.thecus.com.
	Copyrights 
	 This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).
	 This product includes software developed by Mark Murray.
	 This product includes software developed by Eric Young (eay@cryptsoft.com).
	 This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/).
	 This product includes PHP, freely available from (http://www.php.net/).
	 This product includes software developed by the University of California, Berkeley and its contributors.
	 This product includes software developed by Winning Strategies, Inc.
	 This product includes software developed by the Apache Group for use in the Apache HTTP server project (http://www.apache.org/).
	 This product includes software developed by Softweyr LLC, the University of California, Berkeley, and its contributors.
	 This product includes software developed by Bodo Moeller.
	 This product includes software developed by Greg Roelofs and contributors for the book, "PNG: The Definitive Guide," published by O'Reilly and Associates.
	 This product includes software developed by the NetBSD Foundation, Inc. and its contributors.
	 This product includes software developed by Yen Yen Lim and North Dakota State University.
	 This product includes software developed by the Computer Systems Engineering Group at Lawrence Berkeley Laboratory.
	 This product includes software developed by the Kungliga Tekniska Högskolan and its contributors.
	 This product includes software developed by the Nick Simicich.
	 This product includes software written by Tim Hudson (tjh@cryptsoft.com).
	 This product includes software developed by Christopher G. Demetriou for the NetBSD Project.
	CGIC License Terms

	Basic License
	CGIC, copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by Thomas Boutell and Boutell.Com, Inc.
	Permission is granted to use CGIC in any application, commercial or noncommercial, at no cost. HOWEVER, this copyright paragraph must appear on a "credits" page accessible in the public online and offline documentation of the program. Modified versions of the CGIC library should not be distributed without the attachment of a clear statement regarding the author of the modifications, and this notice may in no case be removed. Modifications may also be submitted to the author for inclusion in the main CGIC distribution.
	GNU General Public License

	Version 2, June 1991
	Copyright © 1989, 1991 Free Software Foundation, Inc.
	51 Franklin St, Fifth Floor, Boston, MA  02110-1301  USA
	Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
	PREAMBLE
	The licenses for most software are designed to take away your freedom to share and change it.  By contrast, the GNU General Public License is intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users.  This General Public License applies to most of the Free Software
	Foundation's software and to any other program whose authors commit to using it.  (Some other Free Software Foundation software is covered by the GNU Library General Public License instead.)  You can apply it to your programs, too.
	When we speak of free software, we are referring to freedom, not price.  Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and that you know you can do these things.
	To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.
	For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you have. You must make sure that they, too, receive or can get the source code.  And you must show them these terms so they know their rights.
	We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute and/or modify the software.
	Also, for each author's protection and ours, we want to make certain that everyone understands that there is no warranty for this free software.  If the software is modified by someone else and passed on, we want its recipients to know that what they have is not the original, so that any problems introduced by others will not reflect on the original authors' reputations.
	Finally, any free program is threatened constantly by software patents.  We wish to avoid the danger that redistributors of a free program will individually obtain patent licenses, in effect making the program proprietary.  To prevent this, we have made it clear that any patent must be licensed for everyone's free use or not licensed at all.
	The precise terms and conditions for copying, distribution and modification follow.
	TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
	0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be distributed under the terms of this General Public License.  The "Program", below, refers to any such program or work, and a "work based on the Program" means either the Program or any derivative work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated into another language.  (Hereinafter, translation is included without limitation in the term "modification".)  Each licensee is addressed as "you".
	Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.  The act of running the Program is not restricted, and the output from the Program is covered only if its contents constitute a work based on the Program (independent of having been made by running the Program).
	Whether that is true depends on what the Program does.
	1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and give any other recipients of the Program a copy of this License along with the Program.
	You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.
	2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:
	a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.
	b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.
	c) If the modified program normally reads commands interactively when run, you must cause it, when started running for such interactive use in the most ordinary way, to print or display an announcement including an appropriate copyright notice and a notice that there is no warranty (or else, saying that you provide a warranty) and that users may redistribute the program under these conditions, and telling the user how to view a copy of this License.  (Exception: if the Program itself is interactive but does not normally print such an announcement, your work based on the Program is not required to print an announcement.)
	These requirements apply to the modified work as a whole.  If identifiable sections of that work are not derived from the Program, and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works.  But when you distribute the same sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.
	Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the Program.
	In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.
	3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:
	a) Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
	b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
	c) Accompany it with the information you received as to the offer to distribute corresponding source code.  (This alternative is allowed only for noncommercial distribution and only if you received the program in object code or executable form with such an offer, in accord with Subsection b above.)
	The source code for a work means the preferred form of the work for making modifications to it.  For an executable work, complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the executable.  However, as a special exception, the source code distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.
	If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place counts as distribution of the source code, even though third parties are not compelled to copy the source along with the object code.
	4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License.  Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.
	5. You are not required to accept this License, since you have not signed it.  However, nothing else grants you permission to modify or distribute the Program or its derivative works.  These actions are prohibited by law if you do not accept this License.  Therefore, by modifying or distributing the Program (or any work based on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Program or works based on it.
	6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions.  You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties to this License.
	7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License.  If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Program at all.  For example, if a patent license would not permit royalty-free redistribution of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Program.
	If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply and the section as a whole is intended to apply in other circumstances.
	It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system, which is implemented by public license practices.  Many people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that choice.
	This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.
	8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places the Program under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded.  In such case, this License incorporates the limitation as if written in the body of this License.
	9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time.  Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.
	Each version is given a distinguishing version number.  If the Program specifies a version number of this License which applies to it and "any later version", you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation.  If the Program does not specify a version number of this License, you may choose any version ever published by the Free Software Foundation.
	10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to the author to ask for permission.  For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this.  Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.
	NO WARRANTY
	11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
	12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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